Dual-Stack Split for SAP Systems Based on SAP NetWeaver 7.1 to 7.5 on Windows
# Content

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Introduction</strong></td>
<td>6</td>
</tr>
<tr>
<td>1.1</td>
<td>About This Document</td>
<td>6</td>
</tr>
<tr>
<td>1.2</td>
<td>Use Cases of Dual-Stack Split.</td>
<td>7</td>
</tr>
<tr>
<td>1.3</td>
<td>About Software Provisioning Manager</td>
<td>8</td>
</tr>
<tr>
<td>1.4</td>
<td>Naming Conventions</td>
<td>8</td>
</tr>
<tr>
<td>1.5</td>
<td>New Features</td>
<td>9</td>
</tr>
<tr>
<td>1.6</td>
<td>Constraints</td>
<td>11</td>
</tr>
<tr>
<td>1.7</td>
<td>SAP Notes for the Dual-Stack Split</td>
<td>12</td>
</tr>
<tr>
<td>1.8</td>
<td>Accessing the SAP Library</td>
<td>12</td>
</tr>
<tr>
<td>1.9</td>
<td>How to Use this Guide</td>
<td>13</td>
</tr>
<tr>
<td>2</td>
<td><strong>Split Options Covered by this Guide</strong></td>
<td>14</td>
</tr>
<tr>
<td>2.1</td>
<td>Split Option: Move Java Database</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Operating System and Database Migration During Dual-Stack Split</td>
<td>17</td>
</tr>
<tr>
<td>2.2</td>
<td>Split Option: Keep Database</td>
<td>19</td>
</tr>
<tr>
<td>3</td>
<td><strong>Planning</strong></td>
<td>24</td>
</tr>
<tr>
<td>3.1</td>
<td>Planning Checklist</td>
<td>24</td>
</tr>
<tr>
<td>3.2</td>
<td>Domain or Local Installation</td>
<td>27</td>
</tr>
<tr>
<td>3.3</td>
<td>User Management</td>
<td>28</td>
</tr>
<tr>
<td>4</td>
<td><strong>Preparation</strong></td>
<td>29</td>
</tr>
<tr>
<td>4.1</td>
<td>Preparation Checklist</td>
<td>29</td>
</tr>
<tr>
<td>4.2</td>
<td>Performing Basic Windows Preparation Steps</td>
<td>30</td>
</tr>
<tr>
<td>4.3</td>
<td>Required User Authorization for Running the Installer</td>
<td>32</td>
</tr>
<tr>
<td>4.4</td>
<td>Using Virtual Host Names</td>
<td>34</td>
</tr>
<tr>
<td>4.5</td>
<td>Performing a Full System Backup</td>
<td>34</td>
</tr>
<tr>
<td>4.6</td>
<td>Preparing the Dual-Stack Split Media</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>Downloading and Extracting the Software Provisioning Manager Archive.</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>Using the Physical Media from the Installation Package</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>Downloading the SAP Kernel Archives Required for the Dual-Stack Split (Without Operating System and Database Migration)</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>Downloading the SAP Kernel Archives Required for Operating System and Database Migration</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>Downloading Complete Installation Media</td>
<td>41</td>
</tr>
<tr>
<td>5</td>
<td><strong>Splitting the Dual-Stack System</strong></td>
<td>43</td>
</tr>
<tr>
<td>5.1</td>
<td>Splitting Checklist</td>
<td>43</td>
</tr>
</tbody>
</table>
Document History

i Note

Before you start the implementation, make sure you have the latest version of this document, which is available at https://support.sap.com/sltoolset System Provisioning Split Option of Software Provisioning Manager.

The following table provides an overview on the most important document changes:

Table 1:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.2</td>
<td>2017-09-11</td>
<td>Updated version for software provisioning manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Media Signature Check, documented in: New Features, Running the Installer, Preparing the Dual-Stack Split Media.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Support of Oracle 12.2., documented in: New Features</td>
</tr>
<tr>
<td>2.1</td>
<td>2017-05-22</td>
<td>Updated version for software provisioning manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ New SAPUI5-based graphical user interface (GUI) “SL Common GUI”, documented in: Prerequisites for Running the Installer, Running the Installer, Useful Information About the Installer</td>
</tr>
<tr>
<td>2.0</td>
<td>2017-02-06</td>
<td>Updated version for software provisioning manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Verification of the integrity of data units in Software Provisioning Manager, documented in: New Features, Downloading the Software Provisioning Manager Archive</td>
</tr>
<tr>
<td>1.9</td>
<td>2016-10-07</td>
<td>Updated version for software provisioning manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1.8</td>
<td>2016-06-06</td>
<td>Updated version for software provisioning manager 1.0 SP17 (SL Toolset 1.0 SP17):&lt;br&gt;  ● New feature: Move of AS Java target system to different database type during dual-stack split.&lt;br&gt;    Updated or newly created sections in this documentation:&lt;br&gt;  ○ New Features [page 9]&lt;br&gt;  ○ Operating System and Database Migration During Dual-Stack Split [page 17]&lt;br&gt;  ○ Planning Checklist [page 24]&lt;br&gt;  ○ Preparing the Dual-Stack Split Media [page 35]</td>
</tr>
<tr>
<td>1.7</td>
<td>2016-02-15</td>
<td>Updated version for software provisioning manager 1.0 SP10 (SL Toolset 1.0 SP16)</td>
</tr>
<tr>
<td>1.6</td>
<td>2015-10-12</td>
<td>Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP15)</td>
</tr>
<tr>
<td>1.5</td>
<td>2015-09-14</td>
<td>Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP14)</td>
</tr>
<tr>
<td>1.4</td>
<td>2015-04-27</td>
<td>Updated version for software provisioning manager 1.0 SP08 (SL Toolset 1.0 SP13)</td>
</tr>
<tr>
<td>1.3</td>
<td>2014-11-24</td>
<td>Updated version for software provisioning manager 1.0 SP07 (SL Toolset 1.0 SP12)</td>
</tr>
<tr>
<td>1.2</td>
<td>2014-07-07</td>
<td>Updated version for software provisioning manager 1.0 SP06 (SL Toolset 1.0 SP11)</td>
</tr>
<tr>
<td>1.1</td>
<td>2014-03-17</td>
<td>Updated version for software provisioning manager 1.0 SP05 (SL Toolset 1.0 SP10)</td>
</tr>
<tr>
<td>1.0</td>
<td>2013-10-28</td>
<td>Initial version</td>
</tr>
</tbody>
</table>
1 Introduction

1.1 About This Document

This document explains how to use Software Provisioning Manager 1.0 SP21, which is part of SL Toolset 1.0 SP21, to split a dual-stack (ABAP+Java) system into one ABAP and one Java stack each with its own system ID. You can also use Software Provisioning Manager 1.0 ("the installer" for short) to remove the Java stack of your SAP dual stack-system.

The split procedure is valid for:

- Optional splitting of SAP NetWeaver dual stack-based systems (such as SAP BW systems with SAP BEx Web) and SAP Business Suite systems based on SAP NetWeaver 7.1 and higher.
- Mandatory splitting of SAP NetWeaver dual stack-based systems upgraded to SAP NetWeaver 7.5 Process Integration or SAP Solution Manager 7.2.

For a detailed list of supported SAP system products and releases, see SAP Note 1797362. For information about supported operating system and database platforms, see the Product Availability Matrix at http://support.sap.com/pam.

Related Information

Use Cases of Dual-Stack Split [page 7]
About Software Provisioning Manager [page 8]
Naming Conventions [page 8]
New Features [page 9]
Constraints [page 11]
SAP Notes for the Dual-Stack Split [page 12]
Accessing the SAP Library [page 12]
How to Use this Guide [page 13]
1.2 Use Cases of Dual-Stack Split

Dual-Stack System

A dual-stack system is an SAP system that contains installations of both SAP NetWeaver Application Server for ABAP and SAP NetWeaver Application Server for Java. It has the following characteristics:

- Common SAP system ID (<SAPSID>) for its ABAP and Java stacks
- Common startup framework
- Common database (with different schemes for ABAP and Java)

Dual-Stack Split

While splitting off the Java part of a dual-stack system into a separate system, the dual-stack system is reduced to an ABAP system. To do this, the tool runs a system copy and uses the Java system copy export to reinstall the Java system separately and with a new SAP system ID. The ABAP stack of the former dual-stack system is not affected by this procedure.

The separated systems can either use their own databases (Split Option: Move Java Database) or both use the existing database in the ABAP system (Split Option: Keep Database).

For more information, see:

- Split Option: Move Java Database [page 14]
- Split Option: Keep Database [page 19]
- SAP Note 1797362

Use Case

- For information about the use cases for splitting a dual-stack system, see SAP Note 1655335.
- If you no longer need the Java stack of your SAP dual-stack system, you can remove it as described in Removing the Java Stack [page 77].
- The procedure described in this guide mainly applies to splitting a single SAP dual-stack system. For more information about splitting systems within a system landscape, see Splitting Within a System Landscape [page 72].

More Information

For more information about dual-stack split, see http://scn.sap.com/docs/DOC-25162.
1.3 About Software Provisioning Manager

Software Provisioning Manager 1.0 is the successor of the product- and release-specific delivery of provisioning tools, such as SAPinst. Before you run it, we recommend that you always download the latest version of Software Provisioning Manager 1.0. Software Provisioning Manager 1.0 is part of the Software Logistics Toolset 1.0 (“SL Toolset” for short). This way, you automatically get the latest fixes and supported processes. For more information about Software Provisioning Manager as well as products and releases supported by it, see SAP Note [1680045](http://scn.sap.com/docs/DOC-30236) and [http://scn.sap.com/docs/DOC-30236](http://scn.sap.com/docs/DOC-30236). “SAPinst” has therefore been renamed to “Software Provisioning Manager 1.0” in this documentation. However, the term “SAPinst” is still used in:

- Texts and screen elements in the Software Provisioning Manager GUI
- Naming of executables, for example sapinst.exe

In the following, we generally refer to Software Provisioning Manager 1.0 as the “installer”. We only use the term “Software Provisioning Manager 1.0” if this is required for technical reasons.

Related Information

Preparing the Dual-Stack Split Media [page 35]

1.4 Naming Conventions

- “usage type”, “technical usage”, and “product instance”
  As of Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12), the term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note [1970349](http://scn.sap.com/docs/DOC-30236). Note that there is no terminology change for older releases and all mentioned terms can be used as synonyms. As this guide is a generic document, the currently used terms remain but only “product instance” is going to be used from now on when referring to SAP NetWeaver 7.3 EHP1 and higher.
  For more information, see New Features [page 9].
- SAP system refers to SAP NetWeaver system or SAP system based on SAP NetWeaver.
- Dual-stack system refers to SAP NetWeaver ABAP+Java system or SAP ABAP+Java system based on SAP NetWeaver.
- Only valid for Microsoft Failover Clustering: As of Windows Server 2008 the cluster feature is called Failover Clustering. For practical reasons we are continuing to use the previous terminology Microsoft Cluster Service and abbreviation MSCS in some sections of this guide and the corresponding installation documentation of your release.
1.5  New Features

The table below provides an overview of the new features in Software Provisioning Manager.


Table 2:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Signature Check</td>
<td>The signature of media is checked <strong>automatically</strong> by the installer during the Define Parameters phase while processing the Media Browser screens. As of now the installer only accepts media whose signature has been checked. See also the description of this new security feature in SAP Note 2393060. For more information, see Preparing the Dual-Stack Split Media [page 35] and Running the Installer [page 47].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>Support of Oracle 12.2</td>
<td>Software Provisioning Manager (the “installer”) now supports dual-stack split for SAP systems with Oracle 12.2.</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>SL Common GUI with SAPINST 7.49</td>
<td>With the new installer framework version SAPINST 7.49, you can now use the new SAPUI5-based graphical user interface (GUI) “SL Common GUI”. For more information, see Useful Information About the Installer [page 51], Running the Installer [page 47], and SAP Note 2336746.</td>
<td>Software Provisioning Manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td>Verification of Integrity of Data Units in Software provisioning Manager</td>
<td>The integrity of data units extracted from the Software Provisioning Manager archive is verified. For more information, see Downloading and Extracting the Software Provisioning Manager Archive [page 36]. In addition, check SAP Note 1680045 whether additional information is available.</td>
<td>Software Provisioning Manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td>Move of AS Java Target System to Different Operating System and Database Type During Dual-Stack Split</td>
<td>When performing a dual-stack split, you can now move the Java stack of the dual-stack system being split to an AS Java system on an operating system or database type different from the operating system and database type of the original dual-stack system. For more information, see Operating System and Database Migration During Dual-Stack Split [page 17].</td>
<td>Software Provisioning Manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
</tbody>
</table>

**Note**

With Software Provisioning Manager 1.0 SP17 this feature was already available but only supported for database migration to SAP Solution Manager 7.2 on SAP HANA database. It is now generally supported.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Provisioning for SAP NetWeaver 7.5 and SAP NetWeaver 7.5-based Products</td>
<td>All system provisioning tasks (installation, system copy, system rename) are available for the new SAP NetWeaver 7.5 release. The Dual Stack option, which integrates an AS ABAP and AS Java in a single system (common System ID <code>&lt;SAPSID&gt;</code>, common startup framework, common database), is no longer supported in SAP systems based on SAP NetWeaver 7.5. After upgrading to SAP NetWeaver 7.5 PI, you first have to split the still existing dual stack-system before you can use SAP NetWeaver 7.5 PI productively. For more information, see the Upgrade Master Guide - SAP NetWeaver 7.5 at: <a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td>Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP15)</td>
</tr>
<tr>
<td>System Provisioning for SAP Solution Manager 7.2</td>
<td>All system provisioning tasks (installation, system copy, system rename) are available for the new SAP Solution Manager 7.2 release. Compared to previous SAP Solution Manager releases, SAP Solution Manager 7.2 is no longer provided as a classical dual-stack system (ABAP system with Java Add-in), but consists of a separate ABAP and Java stack.</td>
<td>Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP15)</td>
</tr>
<tr>
<td>Reusing Server Ports from the original dual-stack system that is being split</td>
<td>You can now reuse specific ports from the original dual-stack system in the target Java system, such as the ICM server ports and the message server ports. For more information, see Planning Checklist [page 24].</td>
<td>Software Provisioning Manager 1.0 SP10 (SL Toolset 1.0 SP14)</td>
</tr>
<tr>
<td>Usage Type Library Deprecation for SAP Systems Based on SAP NetWeaver 7.3 EHP1 and Higher</td>
<td>Software Provisioning Manager 1.0 no longer uses the “Usage Types” definitions in its business logic for SAP systems based on SAP NetWeaver 7.3 EHP1 and higher. This is done to unify modeling and terminology across all SAP tools used during the planning, installation and maintenance activities. The “Product Instance” definition replaces “Usage Types” regarding product modeling. For more information, see SAP Notes 1970349 and 1877731.</td>
<td>Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)</td>
</tr>
<tr>
<td>Feedback Evaluation Form</td>
<td>SAP SE’s aim is to provide fast and efficient procedures. To evaluate the procedure you just carried out, we need information generated by the tool during process execution and your experience with the tool itself. A new evaluation form contains a simple questionnaire and XML data generated during the procedure. Port 4239 is used for displaying the feedback evaluation form. For more information, see Prerequisites for Running the Installer [page 46].</td>
<td>Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)</td>
</tr>
</tbody>
</table>
### 1.6 Constraints

You need to consider some constraints before you start splitting your SAP dual-stack system.

- **Dual Stack Split scenario “Keep Database”** (see [Split Option: Keep Database](#)) in a heterogeneous system setup - SCS instance and primary application server (PAS) instance are running on different operating systems - of a distributed target Java system is not supported. This is because the installation of the target SCS instance and PAS instance reuses the kernel, SAPJVM, and other executables of the source PAS instance. Thus the target SCS instance and PAS instance must be installed on an operating system compatible with the kernel of the source PAS instance.

- The dual-stack split procedure does not support the splitting of the following:
  - SAP Process Integration systems based on SAP NetWeaver releases lower than 7.5.
  - SAP Solution Manager systems with releases lower than 7.2.
  - Heterogeneous systems
  - Since MCOD is not supported for SAP systems with SAP ASE, you cannot use split option Keep Database. Instead, you can only use split option Move Java Database.

- The dual-stack split procedure does not implicate the following:
  - Prerequisites Checker
  - SAP host agent
  - Diagnostics agent
  - Additional application server instances

You can ignore sections in the installation documentation that focus on these options.

**Note**

If these options are installed on your SAP dual-stack system and you want to use them on the Java system after the split, you need to install them again on the Java system using the installation media that you used to install your dual-stack system.

- If your source or target database is SAP MaxDB, keep in mind that dual-stack split is only supported for SAP systems running on SAP MaxDB 7.8 or higher.

### Feature Description Table

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option Verify Signed Media</td>
<td>The digital signature ensures that the signatory of a digital document can be identified unambiguously and signatory’s name is documented together with the signed document, the date, and the time. For more information, see SAP Note 1979965.</td>
<td>Software Provisioning Manager 1.0 SP06 (SL Toolset 1.0 SP11)</td>
</tr>
</tbody>
</table>
1.7 SAP Notes for the Dual-Stack Split

You must read the following SAP Notes before you start the dual-stack split. These SAP Notes contain the most recent information on the dual-stack split, as well as corrections to the dual-stack split documentation. Make sure that you have the most up-to-date version of each SAP Note, which you can find at http://support.sap.com/notes.

Table 3: SAP Notes for the Dual-Stack Split

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1680045</td>
<td>Release Note for Software Provisioning Manager 1.0</td>
<td>Software provisioning manager 1.0 with installation, system copy, system rename and dual-stack split for SAP NetWeaver-based systems</td>
</tr>
<tr>
<td>1797362</td>
<td>Dual-Stack Split for Systems Based on SAP NetWeaver</td>
<td>Problems discovered after the publication of the dual-stack split guide</td>
</tr>
<tr>
<td>1655335</td>
<td>Use Cases for Splitting Dual-Stack Systems</td>
<td>—</td>
</tr>
</tbody>
</table>

1.8 Accessing the SAP Library

The references to the SAP NetWeaver Library documentation in this guide always refer to the following on SAP Help Portal:

- SAP systems based on SAP NetWeaver 7.3:
  http://help.sap.com/nw73 Application Help  Function-Oriented View: English
- SAP systems based on SAP NetWeaver 7.3 including Enhancement Package 1:
  http://help.sap.com/nw731 Application Help  Function-Oriented View: English
- SAP systems based on SAP NetWeaver 7.4:
  http://help.sap.com/nw74 Application Help  Function-Oriented View: English
- SAP systems based on SAP NetWeaver 7.5:
  http://help.sap.com/nw75 Application Help  Function-Oriented View: English
1.9 How to Use this Guide

This documentation comprises the description of the dual-stack split procedure and dual-stack-split-specific steps.

For general or installation-specific information, see the Java installation guide relevant for your database and operating system platform, which you can find at:

https://help.sap.com/sitoolset

Area System Provisioning ➤ Guide for Installation of Systems Based on SAP NetWeaver 7.1 and Higher ➤ Installation Guides by Database

In the following, we refer to this documentation as “installation guide”.

Procedure

1. You decide on the split option that you want to use. The following split options are available for central, distributed, and high-availability systems:
   ○ “Move Java Database” (non-MCOD)
   ○ “Keep Database” (MCOD)
   For more information, see Split Options Covered by this Guide [page 14].
2. You follow the list of steps at the beginning of each phase:
   ○ Planning [page 24]
   ○ Preparation [page 29]
   ○ Splitting [page 43]
   ○ Follow-up Activities [page 62]
2 Split Options Covered by this Guide

This section shows the split options covered by this guide. You have to decide which option you want to use because the steps you have to perform vary according to the split option that you choose.

Related Information

Split Option: Move Java Database [page 14]
Split Option: Keep Database [page 19]

2.1 Split Option: Move Java Database

The split option “Move Java Database” offers the possibility to split a dual-stack system into one ABAP system and one Java system each with its own database (non-MCOD).

Only valid for Microsoft Failover Clustering: If your system is a high-availability system with Microsoft Failover Clustering (previously known as MSCS), the split option “Move Java Database” offers the possibility to split a clustered dual-stack system into one ABAP cluster system and one Java cluster system each with its own database (non-MCOD).

If you want to install two Oracle databases on one host, read SAP Note 98252 before installing the second database instance.

Move Java Database for Standard Systems

When you choose the “Move Java Database” option for a standard system, the tool exports the Java stack of the dual-stack system and uses this export to reinstall all main instances on a single host. This equates to an installation of a standard system.

These are the following instances:

- Primary application server instance (PAS instance)
- Central services instance (SCS instance)
- Database instance (DB)

Note

If required, you can install the primary application server instance and the central services instance on the ABAP system host again.
Once the installation has finished and after the System Landscape Directory has been reconfigured, the tool removes all Java parts from the dual-stack system.

Move Java Database for Distributed System

When you choose the “Move Java Database” option for a distributed system, the tool exports the Java stack of the dual-stack system, and uses this export to reinstall the main instances on several hosts. Every instance can run on a separate host. This equates to an installation of a distributed system.

These are the following instances:

- Primary application server instance (PAS instance)
- Central services instance (SCS instance)
- Database instance (DB)

Note

If required, you can reinstall the primary application server instance and the central services instance on the ABAP system hosts.

After the installation has finished and the System Landscape Directory has been reconfigured, the tool removes all Java parts from the dual-stack system.
When you choose the “Move Java Database” option for a high-availability system, the tool exports the Java stack of the dual-stack cluster system, and uses this export to reinstall all mandatory instances on a separate cluster system for Java.

These are the mandatory instances:
- Central services instance for Java (SCS instance)
- Enqueue replication server instance (ERS instance) for the SCS instance
- Database instance (DB)
- Primary application server instance (PAS instance)
- Additional application server instance

After the installation has finished and the System Landscape Directory has been reconfigured, the tool removes all Java parts from the dual-stack cluster system.
2.1.1 Operating System and Database Migration During Dual-Stack Split

During the export of the Java stack in the “Move Database” scenario, you can specify an operating system and database type that is different from the original operating system and database type of the source dual-stack system.

The target Java system that you are about to split off from the source dual-stack system is then installed on this newly specified operating system and database type.

**Recommendation**

We recommend this feature is recommended if you want to upgrade your SAP Solution Manager to release 7.2 and migrate it to SAP HANA.
For more information, see SAP Note 2227300 and SAP Solution Manager 7.2: Simplified Upgrade and Migration to SAP HANA.

If you decide to change the operating system and database type, you must provide the following SAP kernel archives for the target AS Java system. These archives must be Unicode and match the version of the SAP kernel which is used by the dual-stack system. You can download the archives from http://support.sap.com/swdc either beforehand or during the dual-stack split procedure:

- for SAPEXE.SAR
- SAPEXEDB.SAR
- SAPJVM<Version>.SAR
- and IGSEXE.SAR
- optional: SAPCRYPTOLIB.SAR

**Note**

The manifests inside the provided archives are checked, if they match the values of the source system and hardcoded values, such as target operating system or Unicode. The export is created as usual, the so-called EXE.SAR is created from the provided archives, and the SOURCE.PROPERTIES file of the export is updated with the target operating system and database type, overwriting the values of the source dual-stack system. The target Java installation works the same way as if you did not change the operating system and database type.

**Related Information**

Split Option: Move Java Database [page 14]
2.2 Split Option: Keep Database

The split option “Keep Database” offers the possibility for the Java system to reuse the existing database of the dual-stack system using MCOD (multiple components – one database).

**Only valid for Microsoft Failover Clustering:** If your system is a high-availability system with Microsoft Failover Clustering (MSCS), the split option “Keep Database” offers the possibility to split a clustered dual-stack system into one ABAP cluster system and one Java cluster system both using the same database (MCOD).

**Recommendation**

MCOD is generally available and there is no intention to de-support this installation feature. However, SAP recommends that customers should **not** use the MCOD feature when installing new systems.

The major drawbacks are as follows:

- Previous-point-in-time (PPT) recovery of a single system within an MCOD installation becomes a highly complex and time-consuming procedure.
- SAP Landscape Management (LaMa) is generally not supported for MCOD installations. For more information, see SAP Note [1709155](#).
- There are strong dependencies, for example on the database version used for the MCOD system.
- Downtime - planned or unplanned - always affects all systems sharing the same database.

**Exception:** In case of a dual-stack split you can use the “Keep Database” option thus keeping ABAP and Java stack in one database. There, the PPT recovery problem does not apply because both stacks belong logically together and would always be recovered jointly anyhow. However, keep in mind that even for this specific case the introduction of SAP Landscape Management would require a split into separate database subsystems.

Additional information might be available in SAP Note [2146542](#).

---

Keep Database for Central and Distributed Systems

When you choose the “Keep Database” option, the tool exports the Java file system on the dual-stack system. It uses this export to reinstall a central services instance (SCS) and a primary application server instance (PAS) for Java. They can be installed on one host, on different hosts, or on the source system hosts again. Additionally, the tool adapts the Java schema of the database of the dual-stack system to the target Java system.

After the installation has finished and the System Landscape Directory has been reconfigured, the tool removes all Java parts from the dual-stack system except the Java database schema.
Figure 4: Split Option: Keep Database for Standard Systems

ASCS = ABAP Central Services Instance
SCS = Java Central Services Instance
PAS = Primary Application Server Instance
DB = Database Instance
When you choose the “Keep Database” option for a high-availability system, you can choose between the following scenarios:

- **Move SCS to New or Other Cluster**
  The tool exports the Java stack of the dual-stack cluster system and uses this export to install a central services instance and a primary application server instance on a separate cluster system for Java. Additionally, the tool adapts the Java schema of the database of the former dual-stack cluster system to the target Java cluster system.

**Figure 5: Split Option: Keep Database for Distributed Systems**
**Keep SCS on the Source Cluster System**

The tool exports the Java central services instance of the source cluster system and uses this export to install the SCS with a new system ID in a separate cluster on the target cluster system. Additionally, the tool adapts the Java schema of the database to the target Java SID.

**Note**

This scenario is supported as of Windows Server 2008.
After the installation has finished and the System Landscape Directory has been reconfigured, the tool removes all Java parts from the dual-stack cluster system except the Java database schema.
3 Planning

3.1 Planning Checklist

This section includes the planning steps that you must perform when you want to install the new Java system on one or more hosts.

Recommendation

We recommend that you first perform the dual-stack split procedure in a test system to identify possible further application-specific post-split activities required for your scenario.

Perform the planning steps according to the split option and your system variant.

Note

Most of the required planning steps listed in this section are not described in this documentation. You can find the detailed description in the Java installation guide relevant for your database and operating system platform, which you can find at:

https://support.sap.com/sitoolset\ System Provisioning \ Installation Option of Software Provisioning Manager \ Guide for Installation of Systems Based on SAP NetWeaver 7.1 and Higher \ Installation Guides by Database \ <Database> \ <OS Platform> \ Java

In the following, we refer to this documentation as “installation guide”.

Prerequisites

You have decided on your split option [page 14].

Procedure

1. You check the hardware and software requirements for the Java installation host. For more information, see Hardware and Software Requirements in the installation guide.
2. You read about user management [page 28].
3. You identify basic SAP system installation parameters. For more information, see Basic Installation Parameters in the installation guide.
Be aware of the following dual-stack-split-specific deviations:

- **SAP System Parameters:**
  - **User management**: We do not recommend that you make modifications in the user management settings. For more information, see User Management [page 28].
  - **System Landscape Directory (SLD)**: You can ignore SLD parameters.
  - **SAP system ports**: You can specify the ports that you plan to reuse in the Java system you are about to create during the dual-stack split procedure.

  **Note**
  
  If you choose to reuse the ports from the original dual-stack system in the target AS Java system, keep in mind that you cannot access the additional application server instances of the original dual-stack system using these ports any longer during the split procedure, because the original ports are now used by the newly installed Java system.

- **Internet Communication Manager Ports**: You can specify the Internet Communication Manager (ICM) ports that you want the target AS Java to take over from the source system. The selected ports are removed from the primary application server instance of the source system and then inserted in the instance profile of the primary application server instance of the target AS Java system. An ICM server port is the `icm/server_port_<xx>` profile parameter.

  **Note**
  
  Before the ports are moved, they are resolved to numerical values.

- **Message Server Ports**: You can migrate message server ports from the original dual-stack system to the target AS Java system, if you want to ensure that the newly created ABAP and Java systems stay connected. You can move all `ms/server_port_<XX>` port parameters from the SCS instance of the original dual-stack system to SCS instance of the Java system being created during the split procedure.

  **Note**
  
  Before the ports are moved, they are resolved to numerical values.

- **“Move Java Database” and Oracle only: SAP System Database Parameters**: Java database schema. We recommend that you choose a schema ID that is different from your SAP system ID. It might cause problems when you copy a system if `<SCHEMA_ID>` is the same as `<SAPSID>`, and the database-specific method used for the copy does not allow you to rename the database schemas. In certain situations, you might create a system copy with a new `<SAPSID>`, but with the database schema named like the old `<SAPSID>`. This is not a technical problem, but might be confusing to the system administrator.

- **“Move Database” only**: You can specify whether you want to install the split-off target AS Java system on an operating system or database type different from the source dual-stack system. Otherwise the SAP Kernel from the dual-stack system is archived and used to install the target AS Java system on the same operating system and database type as the source dual-stack system.
○ Target Database Type:
  Specify the target database type if you want to migrate the target AS Java system to a database type different from that of the source dual-stack system.

○ Target Operating System:
  Specify the target operating system if you want to migrate the target AS Java system to an operating system different from that of the source dual-stack system.

○ SAP Kernel archives (*.SAR files) downloaded from [http://support.sap.com/swdc](http://support.sap.com/swdc). The archives must be Unicode and of the same version as the SAP Kernel of the dual-stack system.

See also Operating System and Database Migration During Dual-Stack Split [page 17].

4. You decide whether you want to perform a domain or local installation. For more information, see Domain or Local Installation [page 27].

5. Depending on your split option, proceed in one of the following ways:

   ○ “Move Java Database”
     ○ SAP MaxDB:
       ○ You plan your system configuration.
         For more information, see SAP MaxDB System Configuration in the installation guide.
       ○ For the database installation, you decide how to distribute your system components to disk.
         For more information, see Distribution of SAP System Components to Disk in the installation guide.
     ○ Oracle database: For the database installation, you decide how to distribute your database components to disk.
       For more information, see Distribution of SAP System Components to Disk in the installation guide.
     ○ IBM DB2 for Linux, UNIX, and Windows: You plan the setup of your database carefully.
       For more information, see Setup of Database Layout in the installation guide.
     ○ MS SQL Server: For the database installation, you decide how to distribute your database components to disk.
       For more information, see Distribution of SAP System Components to Disk in the installation guide.
     ○ IBM DB2 for z/OS: You plan your system configuration.
       For more information, see System Configuration in the installation guide.

   ○ “Keep Database”
     ○ SAP MaxDB only: You plan your system configuration.
       For more information, see SAP MaxDB System Configuration in the installation guide.
     ○ IBM DB2 for z/OS only: You plan your system configuration.
       For more information, see System Configuration in the installation guide.

6. You decide on the transport host to use.
   For more information, see SAP System Transport Host in the installation guide

7. You plan for adapting the transport routes within your system landscape. For more information, see Splitting Within a System Landscape [page 72].

8. Oracle only: You decide if you want to use Multiple Oracle Homes.
   For more information, see Multiple Oracle Homes in the installation guide.

9. To install a high-availability system with Microsoft Cluster Service (MSCS), you perform the MSCS-specific planning steps as described in the installation guide.

10. You can continue with Preparation [page 29].
3.2 Domain or Local Installation

Use

Before you install the SAP system, you have to decide whether you want to perform a domain or local installation, since this affects how the user account information is stored and accessed.

For more information about the differences between a local and domain installation, go to Start Help and Support and search for What is the difference between a domain and a workgroup?.

Domain Installation

In a domain installation, the user account information is stored centrally in one database on the domain controller and is accessible to all hosts in the system.

You have to perform a domain installation if one of the following applies:

- You install a distributed system.
- You install a high-availability system with Microsoft Failover Clustering.
- You use a common transport host for several SAP systems running on different computers.

Local Installation

In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine (standard system), you can perform a local installation.

Note

If your SAP system was installed as a local installation and you want to later change to a domain installation, you can use the system rename option. For more information, see the System Rename Guide for your SAP system at:

https://support.sap.com/sltoolset

More Information

Required User Authorization for Running the Installer [page 32]
3.3 User Management

The dual-stack split procedure does not change the user management and you cannot choose which kind of user management you want to use for the target AS Java system. That is, the separated Java system and the ABAP system both use the user management of the former dual-stack system. The following is possible:

- If the dual-stack system uses AS ABAP as data source for the User Management Engine (UME), after the split the separated Java stack will also use the ABAP UME.
- If the dual-stack system uses an LDAP directory as source for user data, this is also valid for the Java stack.

In both cases, manual configuration is not required.

We do not recommend that you make modifications to the user management settings.

For more information, see SAP Note 718383.

**Note**

If the UME data source is configured to use an ABAP data source and the UME data source configuration file is not one of the supported files mentioned in SAP Note 718383, the tool does not work.
4 Preparation

4.1 Preparation Checklist

This section includes the preparation steps that you have to perform when you want to install the new Java system on one or more hosts.

**Note**

Most of the required preparation steps listed in this section are not described in this documentation. You can find the detailed description in the Java installation guide relevant for your database and operating system platform, which you can find at:

https://support.sap.com/sltoolset

System Provisioning Installation Option of Software Provisioning Manager Guide for Installation of Systems Based on SAP NetWeaver 7.1 and Higher Installation Guides by Database <Database> <OS Platform> Java

In the following, we refer to this documentation as “installation guide”.

1. You disable the Windows Server firewall on each host.
   For more information about disabling the Windows firewall, see the relevant section in the installation guide.
2. You perform basic preparations on Windows.
   For more information, see Performing Basic Windows Preparation Steps [page 30].
3. Make sure that you use an account with the required user authorization to run the installer.
   For more information, see Required User Authorization for Running the Installer [page 32].
4. IBM DB2 for Linux, UNIX, and Windows only: JSizeCheck requires monitoring functions that are no longer available with IBM DB2 for Linux, UNIX, and Windows version 10.5 by default. Before you start a Java export, you have to create these monitoring functions as follows:
   1. Log on as user db2<dbsid>.
   2. Execute the following command:
      ```
      db2updvl05 -r -d <DBSID> -u db2<dbsid> -p <password>
      ```
5. If applicable, you set up virtual host names.
   For more information, see Using Virtual Host Names [page 34].
6. If required, you prepare the SAP system transport host for your SAP system.
   For more information, see Preparing the SAP System Transport Host in the installation guide.
7. If the Java stack is used as non-ABAP target system, we recommend that you clean up the import queue by importing all transport requests in the queue. If this is not possible, you must copy the import buffer after performing the dual-stack split. For more information, see Configuring Target Systems for Non-ABAP Transports [page 70].
8. If you want to use customized UME data source configuration file, see the SAP Library [page 12] for your release at:

   Security > Identity Management > User Management of the Application Server Java > Configuring User Management > UME Data Sources > LDAP Directory as Data Source > Customizing a UME Data Source Configuration

9. You make sure that the required media are available on each host. You can download the Java stack and database installation media from SAP Service Marketplace as described in Preparing the Dual-Stack Split Media [page 35].

10. **High-availability with Microsoft Cluster Service (MSCS):** To install a high-availability system with Microsoft Cluster Service (MSCS), you also perform the MSCS-specific preparation tasks as described in the installation guide.

11. **High-availability with Microsoft Cluster Service (MSCS):** If you choose the split option “Keep Database” with the scenario “Keep SCS on the Source Cluster System”, you perform the following steps:

   - You provide additional disk storage on the target cluster system.
     For more information, see Distribution of SAP System Components to Disks for MSCS, Directories in an MSCS Configuration, and IP Addresses in an MSCS Configuration in the installation guide.
   - You provide an additional IP address and an additional virtual host name for the Java system.
     For more information, see Mapping Host Names to IP Addresses for MSCS in the installation guide.

12. You can continue with Splitting the Dual-Stack System [page 43].

---

### 4.2 Performing Basic Windows Preparation Steps

#### Use

This section informs you about basic preparation steps that you have to perform before you install the SAP system, including the following:

- Checking the Windows file system
- Checking the Windows domain structure (domain installation only)
- Deciding whether you want to use organizational units (OUs) in the Windows domain (domain installation only)

#### Procedure

**Checking the Windows File System**

You need to check which Windows file system you are using on hosts where you want to install the SAP system.

As of Windows Server 2012 R2, you should use the Windows file system ReFs or NTFS. Older Windows Server versions must use NTFS.
Perform the check as follows:

- **Windows Server 2012 R2 and higher:**
  1. Open PowerShell in elevated mode, and enter the following command:
     ```
     get-volume
     ```
  2. Check that the value *FileSystem* is ReFs or NTFS.

- **Windows Server 2008 (R2) and Windows Server 2012:**
  1. Open the Windows Explorer.
  2. Select the relevant disk.
     The system displays the type of file system in use.
  4. Check that the file system is NTFS.

### Checking the Windows Domain Structure

**Note**

You do not need this step for a local installation.

For a domain installation, we recommend that you check that all SAP system hosts are members of a single Windows domain. We recommend this for all SAP system setups.

We assume that you are familiar with checking Windows domain structures. For more information, see the Windows documentation.

In Windows, you can implement either of the following domain models for the SAP system:

- **Extra domain**
  In this model, the SAP system is embedded in its own domain, which is specially defined for SAP. A second domain exists for the user accounts.
  In Windows, the SAP domain and user domain must be incorporated in a domain tree. In this tree, the user accounts must form the root domain and the SAP domain must be a child domain of this.

- **Single domain**
  In this model, the SAP system, and the user accounts are included in a single domain.

**Caution**

You cannot create local users and groups on the host that is used as domain controller. Therefore, we do not support running an SAP instance (including the database instance) on the host where the domain controller is installed.

### Deciding Whether to Use Organizational Units (OUs) in the Windows Domain

**Note**

You do not need this step for a local installation.
For a domain installation, the installer needs to create certain OS users for SAP and database operations in the Windows domain, also called the “Active Directory” (AD). These users are created by default in the AD container “Users”.

Depending on a customer’s AD landscape and security policy, there are certain restrictions on where to store users and groups in AD. Contact the administrator of your AD infrastructure to understand where to store all SAP and database-related domain users and domain groups.

The SAP installer offers to define an existing OU in AD to create all needed SAP and database users in this OU. There are many different scenarios and prerequisites concerning how to use OUs. For more information, see SAP Note 2247673, which explains these issues in detail and shows some examples of how to use them.

**Caution**

The installer does not create OUs. The installer does not move existing domain users or groups. The installer does not delete existing users, groups, OUs, nor any other object in a Windows domain.

The only exception to this rule is the Uninstall option in SWPM.

### 4.3 Required User Authorization for Running the Installer

Although the installer automatically grants the rights required for the installation to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a **domain** or **local** installation. If necessary, you have to ask the system administrator to grant the account the necessary authorization **before** you start the installation. If you attempt the installation with an account that does not have the required authorization, the installation aborts.

This section informs you about the authorization required for a domain and a local installation.

**Procedure**

**Caution**

*Do not use the user <sapsid>adm for the installation of the SAP system.*

**Domain Installation**

For a domain installation the account used for the installation needs to be a member of the local **Administrators** and the domain **Admins** group of the relevant domain. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across **more than one** machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.
Caution

- If you install a distributed system as a local installation, this can lead to authorization problems for the operating system users `<sapsid>adm` and `SAPService<SAPSID>`. It can also lead to problems with the transport directory, which is usually shared by several SAP systems. SAP does **not** support distributed SAP systems running with local user accounts.
- In a high-availability configuration, you always have to perform a **domain** installation.
- For performance and security reasons, SAP does not support an SAP system installation on a domain controller.
- If for any reason, the account used for the installation is not a member of the domain `Admins` group, you can perform the installation with a domain user who is a member of the local `Administrators` group. However, the domain administrator has to prepare the system appropriately for you.

For more information, see **Performing a Domain Installation without being a Domain Administrator [page 78]**.

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain `Admins` group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain `Admins` group.

**Local Installation**

For a local installation the account used for the installation needs to be a member of the local `Administrators` group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a **single** machine, you can perform a local installation.

Caution

Do not use the Windows built-in account `Administrator` or the renamed built-in account to install your SAP system. The built-in account only has restricted network access rights that are required by the installer. If you renamed the built-in account `Administrator`, do not create a new account named `Administrator`.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local `Administrators` group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local `Administrators` group.

**Related Information**

**Performing a Domain Installation Without Being a Domain Administrator [page 78]**
4.4 Using Virtual Host Names

You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to hide their physical network identities from each other. This can be useful when quickly moving SAP servers or complete server landscapes to alternative hardware since you do not need to reinstall or reconfigure.

Prerequisites

- Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.
- Make sure that you configured the Windows operating system properly to use virtual host names. For more information, see SAP Note 1564275.

Context

⚠️ Caution

High Availability only:
- Only use virtual host names if this is explicitly stated in the parts of this installation guide specific to high availability. Otherwise, use the physical host name.
- Do not start the installer with the command line parameter SAPINST_USE_HOSTNAME=<virtual hostname> on failover cluster nodes.

Procedure

To install a non-high-availability system, proceed as described in SAP Note 1564275.

4.5 Performing a Full System Backup

If you decided to use the split option “Keep Database”. you must perform a full system backup of the dual-stack system before you start the split procedure.

⚠️ Note

If your system is a high-availability system, make sure that you perform a backup of both cluster nodes of the dual-stack system.
If you decided to use the split option “Move Java Database”, you do not need to perform a backup before you start the split procedure.

For more information about backing up your database, see the database-specific backup and recovery documentation in the SAP Library [page 12] for your release and database at:

Table 4:

<table>
<thead>
<tr>
<th>Database</th>
<th>Path in Help Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP MaxDB</td>
<td>SAP NetWeaver Library: Function-Oriented View</td>
</tr>
<tr>
<td></td>
<td>Database Administration Database Administration for SAP MaxDB</td>
</tr>
<tr>
<td>Oracle</td>
<td>SAP NetWeaver Library: Function-Oriented View</td>
</tr>
<tr>
<td></td>
<td>Database Administration Database Administration for Oracle</td>
</tr>
<tr>
<td>IBM DB2 for Linux, UNIX, and Windows</td>
<td>SAP NetWeaver Library: Function-Oriented View</td>
</tr>
<tr>
<td></td>
<td>Database Administration Database Administration for IBM DB2 for Linux, UNIX, and Windows</td>
</tr>
<tr>
<td>IBM DB2 for z/OS</td>
<td>SAP NetWeaver Library: Function-Oriented View</td>
</tr>
<tr>
<td></td>
<td>Database Administration Database Administration for DB2 for z/OS</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>SAP NetWeaver Library: Function-Oriented View</td>
</tr>
<tr>
<td></td>
<td>Database Administration Database Administration for Microsoft SQL Server</td>
</tr>
</tbody>
</table>

4.6 Preparing the Dual-Stack Split Media

This section describes how to prepare the media that is required for the dual-stack split, which are available as follows.

- The Software Provisioning Manager archive containing the installer.
  You always have to download the latest version of the Software Provisioning Manager archive.
- The media containing the software to be installed, which are available as follows:
  - You normally obtain the physical installation media as part of the installation package. You can find them listed under Using the Physical Installation Media from the Installation Package below.
  - As an alternative to downloading the complete SAP kernel media, you can download only the archives (SAR files) that are required from the SAP kernel for the target Java system installation, as described under Downloading the Archives Required for the Dual-Stack Split (Without Operating System and Database Migration) below.
If you want to change the operating system and database type during the dual-stack split (see Operating System and Database Migration During Dual-Stack Split [page 17]), you have to provide the SAPEXE <Version>.SAR, SAPEXEDB <Version>.SAR, SAPJVM <Version>.SAR, igsexe <version>.sar, SAPCRYPTOLIB.SAR (optional) archives for the target operating system and database. You can find the information on where to download these archives under Downloading the Archives Required for Operating System and Database Migration below.

You can also download the complete installation media apart from the Software Provisioning Manager archive from SAP, as described in Downloading the Complete Installation Media below.

**Note**

The signature of media is checked **automatically** by the installer during the Define Parameters phase while processing the Media Browser screens. As of now the installer only accepts media whose signature has been checked. See also the description of this new security feature in SAP Note 2393060.

For more information about which kernel version to use, see SAP Note 1680045. In addition, check the Product Availability Matrix at: http://support.sap.com/pam.

**Related Information**

- Downloading and Extracting the Software Provisioning Manager Archive [page 36]
- Using the Physical Media from the Installation Package [page 38]
- Downloading the SAP Kernel Archives Required for the Dual-Stack Split (Without Operating System and Database Migration) [page 39]
- Downloading the SAP Kernel Archives Required for Operating System and Database Migration [page 39]
- Downloading Complete Installation Media [page 41]

### 4.6.1 Downloading and Extracting the Software Provisioning Manager Archive

You must always download and extract the Software Provisioning Manager 1.0 archive from the SAP Software Download Center because you must use the latest version.

**Procedure**

1. Download the latest version of the Software Provisioning Manager 1.0 archive SWPM10SP<Support_Package_Number>_<Version_Number>.SAR from:

   [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) > SUPPORT PACKAGES & PATCHES > By Alphabetical Index (A-Z) > S > SOFTWARE PROVISIONING MANAGER

2. Get the latest version of the SAPCAR tool on the host where you want to run the installer:
a. Go to [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) SUPPORT PACKAGES & PATCHES and search for “sapcar”.
b. Select the archive file for your operating system and download it to an empty directory.
c. To check the validity of the downloaded executable, right-click the executable and choose Properties. On the Digital Signatures tab you can find information about the SAP signature with which the executable was signed.
d. Rename the executable to sapcar.exe.

For more information about SAPCAR, see SAP Note [212876](https://launchpad.support.sap.com/).

3. Using the latest version of SAPCAR, you can verify the signature of the downloaded SWPM10SP_<Support_Package_Number>_<Version_Number>.SAR archive as follows:

a. Get the latest version of the SAPCRYPTOLIB archive to your installation host as follows:

1. Go to [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) SUPPORT PACKAGES & PATCHES and search for “sapcryptolib”.
2. Select the archive file for your operating system and download it to the same directory where you have put the SAPCAR executable.
3. Use the following command to extract the SAPCRYPTOLIB archive to the same directory where you have put the SAPCAR executable:

   ```bash
   sapcar -xvf sapcryptolibp_84.sar -R <target directory>
   ```
4. Download the Certificate Revocation List from [https://tcs.mysap.com/crl/crlbag.p7s](https://tcs.mysap.com/crl/crlbag.p7s) and move it into the same directory.

b. Verify the signature of the downloaded SWPM10SP_<Support_Package_Number>_<Version_Number>.SAR archive by executing the following command:

   ```bash
   <Path to SAPCAR>/<Path to Download Directory>\sapcar.exe -tvVf<Path to Download Directory>\SWPM10SP_<Support_Package_Number>_<Version_Number>.SAR -crl<file name of revocation list>
   ```

4. Unpack the Software Provisioning Manager archive to a local directory using the following command:

   ```bash
   <Path to SAPCAR>\sapcar.exe -xvf<Path to Download Directory>\SWPM10SP_<Support_Package_Number>_<Version_Number>.SAR <Path to Unpack Directory>
   ```

   i Note
   
   Make sure that all users have read permissions for the directory where you want to unpack the installer.

   ! Caution
   
   Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not unpack it to the same folder as other installation media.
4.6.2 Using the Physical Media from the Installation Package

This section describes how you use the physical installation media as part of the installation package.

Procedure

1. Identify the required media as listed below.

   The following table lists the media required for the dual-stack split:

   Table 5:

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central services instance</td>
<td>○ Software Provisioning Manager archive</td>
</tr>
<tr>
<td></td>
<td>○ UC Kernel (folder K_U_&lt;Version_Number&gt;_&lt;_OS&gt;) where “U” means Unicode.</td>
</tr>
<tr>
<td>Central services instance, primary application server instance</td>
<td>○ Software Provisioning Manager archive</td>
</tr>
<tr>
<td></td>
<td>○ UC Kernel (folder K_U_&lt;Version_Number&gt;_&lt;_OS&gt;) where “U” means Unicode.</td>
</tr>
<tr>
<td></td>
<td>○ SAP NetWeaver Java Component (folders JAVA_*)</td>
</tr>
<tr>
<td></td>
<td>○ RDBMS client media</td>
</tr>
<tr>
<td>Move Java Database only: Database instance</td>
<td>○ Software Provisioning Manager archive</td>
</tr>
<tr>
<td></td>
<td>○ UC Kernel (folder K_U_&lt;Version_Number&gt;_&lt;_OS&gt;) where “U” means Unicode.</td>
</tr>
<tr>
<td></td>
<td>○ SAP NetWeaver Java Component (folders JAVA_*)</td>
</tr>
<tr>
<td></td>
<td>○ MS SQL Server, Oracle Database: RDBMS media</td>
</tr>
<tr>
<td></td>
<td>○ MS SQL Server, Oracle Database: RDBMS patch media (if available)</td>
</tr>
</tbody>
</table>

2. Make the installation media available on each installation host as follows:
   a. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager Archive [page 36].
   b. Make the installation media containing the software to be split available.

      You can do this in one of the following ways:

      ○ Copy the required media folders directly to the hosts.
      ○ Mount media on a central media server that can be accessed from the hosts.

Caution

○ If you copy the media to disk, make sure that the paths to the destination location of the copied media do not contain any blanks and commas.
○ If you perform a domain installation and do not want to copy the media but use network drives for mapping the installation media, make sure that the <sapsid>adm user has access to the UNC paths of the network drives.
4.6.3 Downloading the SAP Kernel Archives Required for the Dual-Stack Split (Without Operating System and Database Migration)

As an alternative to providing the complete SAP kernel media, you can also download only the required installation archives for your SAP system installation. During the installation, you can either specify the dedicated path to the archive, or provide the path to a download basket with all downloaded archives.

**Context**

You only need to provide the SAPHOSTAGENT<Version>.SAR for the Java target system host. The remaining software packages required for the Java target system installation are taken from the Java stack of the source system.

**Procedure**

You can download the SAPHOSTAGENT<Version>.SAR archive from the following path:

http://support.sap.com/swdc

Support Packages and Patches ➤ Software Downloads ➤ Support Packages & Patches ➤ By Category ➤ SAP TECHNOLOGY COMPONENTS ➤ SAP HOST AGENT ➤ SAP HOST AGENT 7.21 ➤ <Operating System>

4.6.4 Downloading the SAP Kernel Archives Required for Operating System and Database Migration

If you want to change the operating system and database type during the dual-stack split, you have to provide the SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR, SAPJVM<Version>.SAR, igsexec<version>.sar archives for the target operating system and database.

**Procedure**


2. Choose the required software component and release:
   - For an SAP NetWeaver system choose SAP NetWeaver and complementary products ➤ SAP NetWeaver<Release> ➤ Application Server Java
For an SAP Business Suite system based on SAP NetWeaver, choose **SAP Application Components**

- SAP CRM | SAP ERP | SAP SCM | SAP SRM
- Release
- Entry by Component
- <Java Product Instance>

3. Choose the required package:

**Note**

You have to choose the same operating system type as that of the primary application server of the dual-stack system.

**Caution**

- Make sure that you always use the highest available patch level unless special patch levels are specified for the relevant package in SAP Note 1680045.
- Make sure that you always choose SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR of the same SAP kernel release and extension:

**Example**

- If SAPEXE<Version>.SAR is of version 7.42 EXT, then SAPEXEDB<Version>.SAR must also be of version 7.42 EXT.
- If SAPEXE<Version>.SAR is of version 7.45, then SAPEXEDB<Version>.SAR must also be of version 7.45.

If you provide the archives in one download folder, and there is more than one version of the same archive available - for example SAPEXE<Version>.SAR - and these versions match the product-specific requirements, the installer selects one of these archive versions. If you want a specific archive version to be used, make sure that this is the only version available in the download folder. When running system provisioning in GUI mode, you can also check in the GUI which archive is being used. So even if there is more than one version of the same archive available in the download folder, you can select the exact archive version you want to use and enter the exact path to the required archive file.

- SAPEXE<Version>.SAR:
  - SAP KERNEL <Version> <UC | NUC> <Operating System> #Database independent
- SAPEXEDB<Version>.SAR:
  - SAP KERNEL <Version> <UC | NUC> <Operating System> <Database>
  - igsexe<version>.sar:
  - SAP IGS <Version> <Operating System>
- SAPJVM<Version>.SAR:
- SAP JVM <Version> <Operating System>

If your target system based on SAP NetWeaver 7.3 including EHP1 or lower - that is you have to use SAP Kernel 7.21 - download the latest patch level of SAPCRYPTOLIB <Version>.SAR from the following path:

4.6.5 Downloading Complete Installation Media

This section describes how you download complete media from the SAP Software Download Center.

Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager Archive [page 36].
2. Identify all download objects that belong to one medium according to one of the following:

   - **Download path or location:**
     - To download the complete kernel media, go to [https://support.sap.com/sitoolset System Provisioning] Software Provisioning Manager 1.0 SP<Current Version> Download Kernel releases delivered for SL Toolset SL TOOLSET 1.0 (INSTALLATIONS AND UPGRADES) KERNEL FOR INSTALLATION/SWPM.
     - To download all media required for your SAP product, you can use one of the following navigation paths:
       - [https://launchpad.support.sap.com/#/softwarecenter INSTALLATIONS & UPGRADES By Category SAP NETWEAVER AND COMPLEMENTARY PRODUCTS <Product>]
   - **Material number**
     All download objects that are part of an installation medium have the same material number and an individual sequence number: `<Material_Number>_<Sequence_Number>`

   - **Example**
     51031387_1
     51031387_2
Title

All objects that are part of an installation medium have the same title, such as <Solution><Media_Name><OS> or <Database>RDBMS<OS> for database media.

3. Download the objects to the download directory.

4. To correctly re-combine the media that are split into small parts, unpack all parts into the same directory.

In the unpacking directory, the system creates a subdirectory with a short text describing the medium and copies the data into it. The data is now all in the correct directory, the same as on the medium that was physically produced. For more information, see SAP Note 1258173.

⚠️ Caution

Make sure that you unpack each installation media to a separate folder. Do not unpack installation media to the same folder where you unpack the Software Provisioning Manager archive.

Do not unpack installation media to the same folder where you unpack the SAP kernel archives for archive-based installation.
5 Splitting the Dual-Stack System

5.1 Splitting Checklist

This section includes the splitting steps that you have to perform for the following split options:

- "Move Java Database"
- "Keep Database"

Detailed information about the steps is available in the relevant section.

**Note**

Some of the required processing steps listed in this section are not described in this documentation. You can find the detailed description in the Java installation guide relevant for your database and operating system platform, which you can find at:


In the following, we refer to this documentation as "installation guide".

### Move Java Database

#### Central System

1. **Oracle**: You install the Oracle database software.
   
   For more information, see Installing the Oracle Database Software in the installation guide.

2. **Oracle**: If required, you set up multiple Oracle Homes.
   
   For more information, see Setting Up Multiple Homes in the installation guide.

3. **MS SQL Server**: You install the MS SQL Server database software.
   
   For more information, see Installing the SQL Server Database Software in the installation guide.

4. You check the prerequisites [page 46] and export the Java stack using the installer [page 47].

**Caution**

Make sure that you stop the Java stack of the source system before you start the export. This is not required if you perform the export for test purposes only, that is, you do not use the export in a productive system.

To stop the Java stack, use transaction SMICM on the ABAP stack.
You can decide whether you want the Java stacks of all instances to be activated or deactivated after the export. If you decide to deactivate them, you can restart them later as described in Move Java Database: Restarting Instances [page 76].

5. If AS Java has been disabled, you restart the source system.
6. You check the prerequisites [page 46] and run the installer [page 47] to install a Java only system using the export from the dual-stack system.

Note

Make sure that you choose a system ID for the Java target system that is different from the dual-stack source system ID.

For a list of forbidden system IDs, see also the F1 help in the tool dialog.

7. You continue with Follow-Up Activities [page 62].

Distributed and High-Availability System

1. Oracle: On the database instance host of the Java system, you install the Oracle database software. For more information, see Installing the Oracle Database Software in the installation guide.
2. Oracle: If required, you set up multiple Oracle Homes on the database instance host. For more information, see Setting Up Multiple Homes in the installation guide.
3. On the primary application server instance host of the dual-stack system, you check the prerequisites [page 46] and run the installer [page 47] to export the Java parts of the file system of the primary application server instance.

Caution

Make sure that you stop the Java stack of the source system before you start the export. This is not required if you perform the export for test purposes only, that is, you do not use the export in a productive system.

To stop the Java stack, use transaction SMICM on the ABAP stack.

You can decide whether you want the Java stacks of all instances to be activated or deactivated after the export. If you decide to deactivate them, you can restart them later as described in Move Java Database: Restarting Instances [page 76].

4. If AS Java has been disabled, you restart the source system.
5. You merge the export directories of the database instance and of the central instance.
6. You check the prerequisites [page 46] and run the installer [page 47] to install a central services instance for the Java target system.

Note

Make sure that you choose a system ID for the Java target system that is different from the dual-stack source system ID.

For a list of forbidden system IDs, see also the F1 help in the tool dialog.

7. You check the prerequisites [page 46] and run the installer [page 47] to install a database instance for the Java target system using the export from the dual-stack system.
8. You check the prerequisites [page 46] and run the installer [page 47] to install a primary application server instance for the Java target system using the export from the dual-stack system.
9. You continue with Follow-Up Activities [page 62].

**Keep Database**

1. On the **primary application server instance host** of the dual-stack system, you check the prerequisites [page 46] and run the installer [page 47] to export the file system of the primary application server instance.

   **Caution**
   
   Make sure that you stop the Java stack of the source system before you start the export. This is not required if you perform the export for test purposes only, that is, you will not use the export in a productive system.

   To stop the Java stack, use transaction SMICM on the ABAP stack.

   You can decide whether you want the Java stacks of all instances to be activated or deactivated after the export. If you decide to deactivate them, you can restart them later as described in Move Java Database: Restarting Instances [page 76].

2. If AS Java has been disabled, you restart the source system.

3. You check the prerequisites [page 46] and run the installer [page 47] to install a central services instance for the Java target system.

   **Note**
   
   Make sure that you choose a system ID for the Java target system that is different from the dual-stack source system ID.

   For a list of forbidden system IDs, see also the F1 help in the tool dialog.

4. All databases except IBM DB2 for z/OS: On the **database instance host** of the dual-stack system, you check the prerequisites [page 46] and run the installer [page 47] to adapt the database for the Java target system.

   **Note**
   
   Make sure that you enter the profile directory of the Java target system in the SAP System > General Parameters screen.

5. IBM DB2 for z/OS only: On the **primary application server instance host** of the dual-stack system, you check the prerequisites [page 46] and run the installer [page 47] to adapt the database for the Java target system.

   **Note**
   
   Make sure that you enter the profile directory of the Java target system in the SAP System > General Parameters screen.

6. You check the prerequisites [page 46] and run the installer [page 47] to install a primary application server instance for the Java target system using the export from the dual-stack system.
5.2 Prerequisites for Running the Installer

Make sure you fulfill the following prerequisites before running the installer.

- If you want to use the SL Common GUI, make sure that the following web browser requirements are met:
  - You have one of the following supported browsers on the device where you want to run the SL Common GUI: Google Chrome, Mozilla Firefox, Microsoft Edge, or Microsoft Internet Explorer 11. Always use the latest version of these web browsers.
    
    **Recommendation**
    
    We recommend using Google Chrome.
  - If you copy the SL Common GUI URL manually in the browser window, make sure that you open a new web browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or private browsing mode (Firefox). This is to prevent web browser plugins and settings from interfering with the SL Common GUI.
    
    For more information about the SL Common GUI, see Useful Information About the Installer [page 51].

- You need at least 300 MB of free space in the installation directory for each installation option. In addition, you need 300 MB free space for the installer executables.

- Make sure that the following ports are not used by other processes:
  - When using the SL Common GUI:
    - Port 4237 is used by default as HTTPS port for communication between the installer and the SL Common GUI. If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      
      `SAPINST_HTTPS_PORT=<Free Port Number>`
    - Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing. The filled-out evaluation form is then sent to SAP using HTTPS. If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      
      `SAPINST_HTTP_PORT=<Free Port Number>`
  - When using the Java SDT GUI:
    - Port 21212 is used by default for communication between the installer GUI server and the installer GUI client. If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      
      `SAPINST_DIALOG_PORT=<Free Port Number>`
    - Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing. The filled-out evaluation form is then sent to SAP using HTTPS. If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      
      `SAPINST_HTTP_PORT=<Free Port Number>`
• If you want to change the host name of your system, change the computer name and the host name on OS level and make sure that the host name resolution and UNC paths work. For more information, see SAP Note 23538.
If you want to change the virtual host name, see SAP Note 962955.
• Make sure that you have specified the most important SAP system parameters as described in Basic SAP System Installation Parameters in the installation documentation of your release before you start the installer.
• IBM DB2 for z/OS: Make sure that you have installed DB2 for z/OS. For information on that installation, see SAP DBA Guide: DB2 for z/OS DB2 Setup, especially the section Stored Procedures Enablement.

5.3 Running the Installer

This section describes how to run the installer to perform the dual-stack split.

Prerequisites

For more information, see Prerequisites for Running the Installer [page 46].

Context

Software Provisioning Manager (the “installer” for short) offers two GUIs:
• The new web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short
• The “classic” Java-based GUI with a CUI client and server - “Java SDT GUI” for short

Note

If the SL Common GUI does not meet your requirements you can still use the “classic” Java SDT GUI. You then have to start the sapinst executable with the command line option SAPINST_SLP_MODE=false.

In cases where both GUIs behave the same way, we address them as “installer GUI”.
For more information, see Useful Information About the Installer [page 51].
This procedure describes an installation where you use one of the following GUI scenarios:
• You run the installer and use the SL Common GUI. Then you can control the processing of the installer in the browser running on any device.
• You run the installer and use the Java SDT GUI. Both are running on the same host.
Procedure

1. Log on to the host where you want to run the installer.
   Make sure that you log on as a user with the required authorization for running the installer.
   For more information, see Required User Authorization for Running the Installer [page 32].

   \[Caution\]
   Do not use an existing <sapsid>adm user.

   \[SL Common GUI only\]: If your security policy requires that the person running the installer is not allowed to know administrator credentials on the host where the installer is to perform the dual-stack split, you can specify another operating system user for authentication purposes. You do this using the SAPINST_REMOTE_ACCESS_USER parameter when starting sapinst.exe from the command line. You have to confirm that the user is a trusted one. For more information, see SAP Note 1745524.

2. Make the required media available.
   For more information, see Preparing the Dual-Stack Split Media [page 35].

3. Start the installer as follows:
   Double-click sapinst.exe from the directory to which you unpacked the Software Provisioning Manager archive file.

   \[Note\]
   By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the sapinst executable with command line option SAPINST_BROWSER=<Path to Browser Executable>, for example SAPINST_BROWSER=firefox.exe.

   The installer GUI starts automatically by displaying the Welcome screen.

4. The installer is starting up.
   Depending on the type of the installer GUI you want to use, do one of the following:
   - If you use the SL Common GUI, the installer now starts and waits for the connection with the SL Common GUI. If you have a supported web browser (see Prerequisites for Running the Installer [page 46]) installed on the host where you run the installer, the SL Common GUI starts automatically by displaying the Welcome screen.
   - If the SL Common GUI does not open automatically, you can find the URL you require to access the SL Common GUI at the bottom of the Program Starter window of the installer. You find the icon of the Program Starter window in the taskbar of your Windows host. Open a supported web browser and run the URL from there.

   \[Sample Code\]
   ```
   Open your browser and paste the following URL address to access the GUI
   ```
The SL Common GUI opens in the browser by displaying the *Welcome* screen.

### Note

Before you reach the *Welcome* screen, your browser might warn you that the certificate of the sapinst process on this computer could not be verified. Accept this warning to inform your browser that it can trust this site, even if the certificate could not be verified.

- If you use the Java SDT GUI - that is you started the sapinst executable with command line option `SAPINST_SLP_MODE=false`, the Java SDT GUI starts automatically by displaying the *Welcome* screen.

5. In the *Welcome* screen, choose ![Dual-Stack Split](<Database>) ![Keep Database | Move Java Database](<Standard System|Distributed System|High-Availability System>)

Perform the related dual-stack split options *exactly* in the order they appear.

6. Choose Next.

7. If the installer prompts you to log off from your system, log off and on again.

   The installer restarts automatically.

8. Follow the instructions in the installer input screens and enter the required parameters.

### Note

To find more information on each parameter during the *Define Parameters* phase, position the cursor on the required parameter input field:

- If you use the SL Common GUI, choose either `F1` or the **HELP** tab. Then the available help text is displayed in the **HELP** tab.
- If you use the Java SDT GUI, choose `F1`. Then a dialog opens with the available help text.

### Note

If the installer asks for the Java media, make sure that you provide a Java media with the same release level as your dual-stack system.

### Caution

The signature of media is checked **automatically** during the *Define Parameters* phase while processing the **Media Browser** screens.

Keep in mind that this automatic check is only committed once and **not** repeated if you modify artefacts such as SAR archives or files on the media after the initial check has been done - that is if you modify artefacts later on during the remaining *Define Parameters* phase or later on during the *Execute Service* phase the signature is not checked again.

See also the description of this new security feature in SAP Note [2393060](https://<hostname>:4237/sapinst/docs/index.html).
9. After you have entered all requested input parameters, the installer displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that the installer set by default. If required, you can revise the parameters before starting the dual-stack split procedure.

10. To start the execution, choose Next.

The installer starts the split procedure and displays its progress on the Task Progress screen.

The installer starts the export and displays its progress of the system copy export during the processing phase.

When the dual-stack option has finished successfully, the installer displays the message Execution of <Split_Option> has completed.

11. **IBM DB2 for Linux and UNIX and Windows**: If not already done, install the DB2 license.

   **Note**: If you have bought your DB2 license from SAP (OEM customers), install the DB2 license as described in SAP Note 816773. 

12. If you copied installation media to your hard disk, you can delete these files when the installer has successfully completed.

13. **Java GUI only**: For security reasons, we recommend that you delete the .sdtgui directory within the home directory of the user with which you ran the installer:

    %userprofile%\.sdtgui

**Related Information**

- Useful Information About the Installer [page 51]
- Interrupted Processing of the Installer [page 52]
- Performing Remote Processing of the Installer (Java SDT GUI only) [page 55]
- Starting the Java SDT GUI Separately [page 57]
- Running the Installer in Accessibility Mode [page 59]
- Troubleshooting with the Installer [page 60]

**5.4 Additional Information About the Installer**

The following sections provide additional information about the installer.
5.4.1 Useful Information About the Installer

This section contains some useful technical background information about the installer and the installer GUI.

- Software Provisioning Manager (the installer) offers two GUIs:
  - The new web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short
  - The “classic” Java-based GUI with a CUI client and server - “Java SDT GUI” for short

The SL Common GUI of the Software Provisioning Manager (or “SL Common GUI” for short) uses the SAP UI Development Toolkit for HTML5 - also known as SAPUI5 - a client-side HTML5 rendering library based on JavaScript. The benefits of this new user interface technology for the user are:

- Zero footprint, since only a web browser is required on the client
- New controls and functionality, for example, view logs in web browser.

The SL Common GUI connects the web browser on a client with the sapinst executable - which is part of Software Provisioning Manager - running on the installation host using the standard protocol HTTPS. For the SL Common GUI, the installer provides a pre-generated URL in the Program Starter window. If you have a supported web browser installed on the host where you run the installer, the SL Common GUI starts automatically.

By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the sapinst executable with command line option

```
SAPINST_BROWSER=<Path to Browser Executable>, for example
SAPINST_BROWSER=firefox.exe.
```

Alternatively you can open a supported web browser on any device and run the URL from there.

For more information about supported web browsers see Prerequisites for Running the Installer [page 46].

If the SL Common GUI does not meet your requirements, you can still use the “classic” Java SDT GUI. To do so, you must start the sapinst executable with the command line option

```
SAPINST_SLP_MODE=false.
```

You can switch back to the default installer GUI at any time with the following steps:

1. Stop the installer.
2. Restart the installer with command line option `SAPINST_SLP_MODE=false`.
3. On the What do you want to do? screen choose Continue with the existing run.

- The installer creates the installation directory `sapinst_instdir`, where it keeps its log files, and which is located directly in the `%ProgramFiles%` directory. If the installer is not able to create `sapinst_instdir` there, it tries to create `sapinst_instdir` in the directory defined by the environment variable TEMP.
• For each option, the installer creates a subdirectory located in the sapinst_instdir directory.
• The installer extracts itself to a temporary directory (TEMP, TMP, TMPDIR, or SystemRoot). These executables are deleted after the installer has stopped running. Directories called sapinst_exe.xxxxxx.xxxx sometimes remain in the temporary directory. You can safely delete them. The temporary directory also contains the log file dev_selfex.out from the extraction process, which might be useful if an error occurs.

Caution
If the installer cannot find a temporary directory, the installation terminates with the error FCO-00058.

• To see a list of all available installer properties, go to the directory %TEMP%\sapinst_exe.xxxxxx.xxxx after you have started the installer, and enter the following command:
sapinst.exe -p
• This information is only relevant if you use the Java GUI of the installer: If you need to run the installer in accessibility mode, proceed as described in Running the Installer in Accessibility Mode [page 59].
• If required, stop the installer by choosing one of the following, depending on the installer GUI you use:
  ○ In the SL Common GUI, choose the Cancel button.
  ○ In the Java SDT GUI, choose SAPinst Exit Process in the Java SDT GUI menu.

Note
If you need to terminate the installer, choose File Exit in the menu of the Program Starter window.

5.4.2 Interrupted Processing of the Installer

Here you find information about how to restart the installer if its processing has been interrupted.

Context

The processing of the installer might be interrupted for one of the following reasons:
• An error occurred during the Define Parameters or Execute phase:
The installer does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description of the choices listed in the table below as well as a path to a log file that contains detailed information about the error.
• You interrupted the installation by choosing
  ○ Cancel in the SL Common GUI
  ○ Exit Process in the SAPinst menu in the Java SDT GUI
Caution

If you stop an option in the Execute phase, any system or component installed by this option is incomplete and not ready to be used. Any system or component uninstalled by this option is not completely uninstalled.

The following table describes the options in the dialog box:

Table 6:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry</td>
<td>The installer retries the installation from the point of failure without repeating any of the previous steps. This is possible because the installer records the installation progress in the keydb.xml file. We recommend that you view the entries in the log files, try to solve the problem, and then choose Retry. If the same or a different error occurs, the installer displays the same dialog box again.</td>
</tr>
<tr>
<td>Stop</td>
<td>The installer stops the installation, closing the dialog box, the installer GUI, and the GUI server. The installer records the installation progress in the keydb.xml file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td>Continue</td>
<td>The installer continues the installation from the current point.</td>
</tr>
<tr>
<td>View Log</td>
<td>Access installation log files.</td>
</tr>
</tbody>
</table>

The following procedure describes the steps to restart an installation, which you stopped by choosing Stop, or to continue an interrupted installation after an error situation.

Procedure

1. Log on to the installation host as a user with the required permissions as described in Running the Installer [page 47].
2. Make sure that the media required for the dual-stack split are still available.

   For more information, see Preparing the Dual-Stack Split Media [page 35].

   ➤ Recommendation

   Make the installation media available locally. For example, if you use remote file shares on other Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from media mounted with NFS might fail.
3. Restart the installer by double-clicking `sapinst.exe` from the directory to which you unpacked the Software Provisioning Manager archive.

By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the `sapinst` executable with command line option `SAPINST_BROWSER=<Path to Browser Executable>`, for example `SAPINST_BROWSER=firefox.exe`.

4. The installer is restarting.

Depending on the type of the installer GUI you want to use, do one of the following:

- If you use the SL Common GUI, the installer now starts and waits for the connection with the SL Common GUI. If you have a supported web browser (see Prerequisites for Running the Installer [page 46]) installed on the host where you run the installer, the SL Common GUI starts automatically by displaying the `Welcome` screen.

If the SL Common GUI does not open automatically, you can find the URL you require to access the SL Common GUI at the bottom of the `Program Starter` window of the installer. You find the icon of the `Program Starter` window in the taskbar of your Windows host. Open a supported web browser and run the URL from there.

```
Sample Code

...
******************************************************************************
*******
Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html
Logon users: [<users>]
******************************************************************************
*******
...
```

The SL Common GUI opens in the browser by displaying the `Welcome` screen.

- If you use the Java SDT GUI - that is you started the sapinst executable with command line option `SAPINST_SLP_MODE=false`, the Java SDT GUI starts automatically by displaying the `Welcome` screen.

5. From the tree structure on the `Welcome` screen, select the installation option that you want to continue and choose `Next`.

The `What do you want to do?` screen appears.

6. On the `What do you want to do?` screen, decide between the following alternatives and continue with `Next:`
Table 7:

<table>
<thead>
<tr>
<th>Alternative</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform a new run</td>
<td>The installer does not continue the interrupted dual-stack split option. Instead, it moves the content of the old installer directory and all installer-specific files to a backup directory. Afterwards, you can no longer continue the old option. The following naming convention is used for the backup directory: log_&lt;Day&gt;<em>&lt;Month&gt;</em>&lt;Year&gt;<em>&lt;Hours&gt;</em>&lt;Minutes&gt;_&lt;Seconds&gt;</td>
</tr>
<tr>
<td>Example</td>
<td>log_01_Oct_2016_13_47_56</td>
</tr>
<tr>
<td>Note</td>
<td>All actions taken by the dual-stack split before you stopped it (such as creating directories or users) are not revoked.</td>
</tr>
<tr>
<td>Caution</td>
<td>The installer moves all the files and folders to a new log directory, even if these files and folders are owned by other users. If there are any processes currently running on these files and folders, they might no longer function properly.</td>
</tr>
<tr>
<td>Continue with the existing one</td>
<td>The installer continues the interrupted dual-stack split from the point of failure.</td>
</tr>
</tbody>
</table>

5.4.3 Performing Remote Processing of the Installer (Java SDT GUI only)

Here you find information about how to process the installer on a remote host.

Note

This section is only valid if you use the Java SDT GUI. That is, you started the sapinst executable with command line option SAPINST_SLP_MODE=false.

Prerequisites

- The remote host meets the prerequisites for starting the installer as described in Prerequisites for Running the Installer [page 46].
- Both computers are in the same network and can ping each other.
To test this:
1. Log on to your remote host and enter the command: `ping <Local_Host>`
2. Log on to the local host and enter the command: `ping <Remote_Host>`

- If you need to specify another operating system user with the `SAPINST_REMOTE_ACCESS_USER` command line parameter, make sure that this user exists on the remote host.

**Context**

You use this procedure to process the installer on a remote host. In this case, the installer runs on the remote host, and the installer GUI runs on the local host. The local host is the host from which you control the installation with the installer GUI. The installer GUI connects using a secure SSL connection to the installer.

If your security policy requires that the person performing the installation by running the installer GUI on the local host is not allowed to know administrator credentials on the remote host, you can specify another operating system user for authentication purposes. You do this using the `SAPINST_REMOTE_ACCESS_USER` parameter when starting `sapinst.exe` from the command line. You have to confirm that the user is a trusted one. For more information, see SAP Note 1745524.

**Procedure**

1. Log on to the remote host as a user with the required authorization for running the installer.
   For more information, see Required User Authorization for Running the Installer [page 32].
2. Make the installation media available on your remote host.
   For more information, see Preparing the Dual-Stack Split Media [page 35].
3. Open a command prompt and change to the directory to which you unpacked the Software Provisioning Manager archive.
4. Check the version of the `sapinst` executable by entering the following command:
   ```
   sapinst.exe -sfxver
   ```
   The version of the `sapinst` executable must be exactly the same as the version of the `sapinstgui` executable on the local host (see also Starting the Installer GUI Separately [page 57]).
5. Start the installer by entering the following command:
   ```
   sapinst.exe
   ```

   **Note**

   If you need to specify another operating system user for authentication purposes, enter the following command:
   ```
   sapinst.exe SAPINST_REMOTE_ACCESS_USER=<Specified_OS_User>
   ```
The installer now starts and waits for the connection to the installer GUI. You see the following at the command prompt:

guiengine: no GUI connected; waiting for a connection on host <Host_Name>, port <Port_Number> to continue with the installation

6. Start the installer GUI on your local host as described in Starting the Installer GUI Separately [page 57].

5.4.4 Starting the Java SDT GUI Separately

Here you find information about how to start the Java SDT GUI separately.

### Note

This section is only valid if you use the Java SDT GUI. That is, you started the sapinst executable with command line option `SAPINST_SLP_MODE=false`.

### Prerequisites

The host on which you want to start the installer GUI meets the prerequisites for starting the installer as described in Prerequisites for Running the Installer [page 46].

### Note

If you want to run the installer on a UNIX host, make sure that you meet the prerequisites for the installer listed in the relevant UNIX guide.

### Context

You might need to start the installer GUI separately in the following cases:

- You closed the installer GUI using File Close GUI only from the installer menu while the installer is still running.
- You want to perform a remote installation, where the installer GUI runs on a different host from the installer. For more information, see Performing Remote Processing of the Installer (Java SDT GUI only) [page 55].

In this procedure, the following variables are used: `<Remote_Host>` is the name of the remote host, and `<Port_Number_Gui_Server_To_Gui_Client>` is the port the GUI server uses to communicate with the GUI client (21212 by default).
Procedure

- **Starting the Installer GUI on Windows**
  
  a. Make the installer software available on the host on which you want to start the installer GUI. For more information, see Preparing the Dual-Stack Split Media [page 35].
  
  b. Start the installer GUI by executing the `sapinstgui` executable with the appropriate command line parameters:
     
     - If you want to perform a remote installation, proceed as follows:
       
       1. Check the version of `sapinstgui.exe` by entering the following command:
          
          `<Path_To_Unpack_Directory>\sapinstgui.exe -sfxver`
          
          The version of the `sapinstgui` executable must be exactly the same as the version of the `sapinst` executable on the remote host (see also Performing a Remote Installation [page 55]).
          
       2. Start the installer GUI by entering the following command:
          
          `<Path_To_Unpack_Directory>\sapinstgui.exe -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>`
          
     - If you closed the installer GUI using **File > Close GUI only** and want to reconnect to the installer, proceed as follows:
       
       1. If you are performing a local installation with the installer and the installer GUI running on the same host, execute the following command:
          
          `<Path_To_Unpack_Directory>\sapinstgui.exe -port <Port_Number_Gui_Server_To_Gui_Client>`
          
       2. If you are performing a remote installation with the installer and the installer GUI running on different hosts, execute the following command:
          
          `<Path_To_Unpack_Directory>\sapinstgui.exe -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>`
          
  c. The installer GUI starts and connects to the installer.

- **Starting the Installer GUI on UNIX**
  
  a. Make the installer software available on the host on which you want to start the installer GUI.  
  
  For more information, see Preparing the Dual-Stack Split Media [page 35].

  b. Start the installer GUI by executing the `sapinstgui` executable with the appropriate command line parameters:

     - If you want to perform a remote installation, proceed as follows:
       
       1. Check the version of the `sapinstgui` executable by entering the following command:
          
          `<Path_To_Unpack_Directory>/sapinstgui -sfxver`
          
          The version of the `sapinstgui` executable must be exactly the same as the version of the `sapinst` executable on the remote host (see also Performing a Remote Installation [page 55]).
          
        2. Start the installer GUI by entering the following command:
           
           `<Path_To_Unpack_Directory>/sapinstgui -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>`
If you closed the installer GUI using File > Close GUI only and want to reconnect to the installer, proceed as follows:

1. If you are performing a local installation with the installer and the installer GUI running on the same host, execute the following command:
   `<Path_To_Unpack_Directory>/sapinstgui -port <Port_Number_Gui_Server_To_Gui_Client>`

2. If you are performing a remote installation with the installer and the installer GUI running on different hosts, execute the following command:
   `<Path_To_Unpack_Directory>/sapinstgui -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>`

c. The installer GUI starts and connects to the installer.

5.4.5 Running the Installer in Accessibility Mode

You can also run the installer in accessibility mode.

### Note

The information contained in this section is only valid if you use the Java SDT GUI. That is, you started the sapinst executable with command line option `SAPINST_SLP_MODE=false`.

If you use the SL Common GUI, apply the standard accessibility functions of your web browser.

### Context

The following features are available:

- **Keyboard access:**
  This feature is generally available for all operating systems.

- **High-contrast color:**
  This feature is derived from the Windows display properties. You can use it either for a local installation or for a remote installation.

- **Custom font setting:**
  This feature is derived from the Windows display properties. You can use it either for a local installation or for a remote installation.

### Procedure

- **Activating and Adjusting Accessibility Settings on Windows**

  You first have to activate and adjust the relevant settings for the font size and color schemes **before** you start the installer or the installer GUI.
The following procedure applies for Windows Server 2012 and might be different when using another Windows operating system.

a. Right click on your Windows desktop and choose **Personalize**.

b. Select **Adjust font size (DPI)** and choose **Larger scale (120 DPI)**.

   To define other font size schemes, choose **Custom DPI**.

c. In the right-hand pane, select **Window Color and Appearance**.

   Select a color scheme from the **Color scheme** drop-down box.

   To define your own color schemes, choose **Advanced**.

- **Running the Installer in Accessibility Mode**

You can either perform a local installation, where the installer and the installer GUI are running on the same host, or a remote installation, where the installer and the installer GUI are running on different hosts.

- Local installation:
  
  Start the software provisioning manager as described in **Running the Installer** [page 47] by executing the following command:

  `<Path_To_Unpack_Directory>\sapinst.exe` -accessible

- Remote installation:

  1. Start the installer on the remote host by executing the following command from the command line as described in **Performing Remote Processing of the Installer (Java SDT GUI only)** [page 55]:

     `<Path_To_Unpack_Directory>\sapinst.exe`

  2. Start the installer GUI on the local host by executing the following command from the command line as described in **Starting the Java SDT GUI Separately** [page 57]:

     `<Path_To_Unpack_Directory>\sapinstgui.exe` -accessible -host `<Remote_Host>` -port `<Port_Number_Gui_Server_To_Gui_Client>`

### 5.4.6 Troubleshooting with the Installer

This section tells you how to proceed when errors occur while the installer is running.

#### Context

If an error occurs, the installer:

- Stops processing
- Displays a dialog informing you about the error
Procedure

1. Check SAP Note 1548438 for known installer issues.
2. If an error occurs during the Define Parameters or the Execute Service phase, do one of the following:
   ○ Try to solve the problem:
     ○ To check the installer log files (sapinst.log and sapinst_dev.log) for errors, choose:
       ○ The LOG FILES tab, if you are using the SL Common GUI.
       ○ The View Logs menu item, if you are using the Java SDT GUI.
     ○ To check the log and trace files of the installer GUI for errors:
       ○ If you use the SL Common GUI, you can find them in the directory %userprofile% \.sapinst\.
       ○ If you use the Java SDT GUI, you can find them in the directory %userprofile%\.sdtgui\.
         ○ If the GUI server or the installer GUI do not start, check the file sdtstart.err in the current %userprofile% directory.
         ○ If the installer GUI aborts without an error message, restart the installer GUI as described in Starting the Installer GUI Separately [page 57].
         ○ **High Availability only:** If you experience network connection problems, check IPv4 Host name resolution as described in SAP Note 1365796.
     ○ Then continue by choosing Retry.
   ○ If you cannot resolve the problem, abort the installer by choosing one of the following, depending on the type of installer GUI you use:
     ○ If you use the SL Common GUI, choose Cancel in the tool menu.
     ○ If you use the Java SDT GUI, choose Stop from the error message or SAPinst Exit Process in the tool menu.
     For more information, see Interrupted Processing of the Installer [page 52].
3. If you cannot resolve the problem, report an incident using the appropriate subcomponent of BC-INS*.
   For more information about using subcomponents of BC-INS*, see SAP Note 1669327.
6 Follow-Up Activities

6.1 Follow-Up Activities Checklist

This section includes the follow-up activities that you have to perform for the split options “Move Java Database” and “Keep Database”.

Context

Note

Most of the required steps listed in this section are not described in detail in this documentation. You can find the detailed description in the Java system copy guide relevant for your database and operating system platform, which you can find at:

https://support.sap.com/sitoolset > System Provisioning > System Copy Option of Software Provisioning Manager > System Copy Guides

In the following, we refer to this documentation as “system copy guide”.

Procedure

1. On the Java target system, you install the SAP license.
   
   **High-Availability System only:** If your system is a high-availability system, you install a license on each cluster node of the Java target system.
   
   For more information, see Installing the License Key [page 64].

2. On the Java target system, you maintain the connection to the system landscape directory [page 65].

3. On the Java target system, you generate the public-key certificates.
   
   For more information, see Generating Public-Key Certificates [page 64].

4. **IBM DB2 for Linux and UNIX and Windows** only: On the Java target system, you enable the recoverability of the database.
   
   For more information, see Enabling Recoverability of the IBM DB2 for Linux, UNIX, and Windows Database [page 67].

5. You must recreate the JCo destinations as described in the documentation Creating JavaConnector (JCo) Destinations in the SAP Library [page 12] at: Application Server > Application Server Java > Developing Java Web Dynpro Applications > Content Administration and Measurements > Web Dynpro Content Administrator > Functions for JCo Destinations.
See also SAP Note 899144.

6. On the Java target system, you perform product instance or usage type-specific follow-up activities as required.
   For more information, see the relevant sections in the product instance or usage type-specific follow-up activities in the system copy guide.

7. We recommend that you perform regression testing.

8. Depending on your system variant, proceed in one of the following ways:
   ○ Standard system
     On the source system, you run the installer [page 47] to remove the Java parts in the file system and in the database.
   ○ Distributed or High-Availability System
     1. On the additional application server instance host of the source system, you run the installer [page 47] to remove the Java parts from the additional application server instance.

   Note
   “Keep Database” only:
   Before you start removing the Java parts from your source system, you have to adapt the Secure Store of the dual-stack system. Follow the instructions that are displayed at the end of the Adapt Database for Java Target System step.

     2. On the primary application server instance host of the source system, you run the installer [page 47] to remove the Java parts from the primary application server instance.
     3. On the central services instance host of the source system, you run the installer [page 47] to remove the central services instance.
     4. On the enqueue replication server instance host of the source system, you run the installer [page 47] to remove the enqueue replication server instance.
     5. “Move Java Database” only: On the database host of the source system, you run the installer [page 47] to remove the Java database schema.

9. On the ABAP system, you call transaction RZ10 to reimport the profiles from the file system.

10. If the ABAP system is part of a non-ABAP transport landscape, you perform Follow-Up Activities for the Enhanced Change and Transport System [page 69].

11. If required and not already done so, you configure the CTS Deploy Web Service [page 71] on the ABAP system.

12. Maintain the secinfo and reginfo files in the ABAP system.

   For more information, see the SAP Library at http://help.sap.com/nw75 and SAP NetWeaver Security Guide Security Guides for Connectivity and Interoperability Technologies Security Settings in the Gateway Configuring Connections between Gateway and External Programs Securely SAP Gateway Security Files secinfo and reginfo and SAP Note 1408081. For SAP Process Integration 7.5, see SAP Note 2367160.

13. You clean up the system landscape data [page 75].

14. To remove obsolete SLD data, see the following document:
6.1.1 Installing the License Key

Once the installation of the target system is completed and the SAP system copy has been imported, you have to install a new license key.

You must install a permanent SAP license. When you install your SAP system, a temporary license is automatically installed.

**Note**

If the copied system has a valid permanent license for AS Java, this license key is preserved in the target system. This means, no temporary license is installed if a valid permanent license key is detected in the target system.

For more information about ordering and installing the SAP license, see the SAP Library [page 12] for your release at:

- SAP NetWeaver Composition Environment 7.1 / 7.1 including Enhancement Package 1:
  - Administrator’s Guide > Configuration of SAP NetWeaver CE > Initial System Configuration > Licensing the AS Java
- SAP NetWeaver Composition Environment 7.2:
  - Administrator’s Guide > Configuration of SAP NetWeaver CE > Configuring Mandatory Components > Configuring Application Server Java > Mandatory Configuration Tasks > Licensing the AS Java
- SAP NetWeaver 7.3 and higher:
  - Solution Life Cycle Management > SAP Licenses

6.1.2 Generating Public-Key Certificates

Reconfiguring the Public-Key Certificates

After the system copy, the public-key certificates are not correct on the target system. You need to reconfigure them as described in the SAP Library [page 12] for your release at:

- SAP NetWeaver Composition Environment 7.1 / 7.1 including Enhancement Package 1 / 7.2:
- SAP NetWeaver 7.3 and higher:
Importing the Public-Key Certificates

You also need to import this public-key certificate on any systems that are to accept logon tickets from the AS Java system. For more information, see the SAP Library [page 12] for your release at:

- SAP NetWeaver Composition Environment 7.1 / 7.1 including Enhancement Package 1 / 7.2:
  
  | Administrator’s Guide | Configuration of SAP NetWeaver CE | Initial System Configuration |
  | Single Sign-On for Web-Based Access | Using Logon Tickets | Using Logon Tickets with AS Java | Configuring the AS Java to Issue Logon Tickets |

- SAP NetWeaver Composition Environment 7.2:

  | Single Sign-On for Web-Based Access | Using Logon Tickets | Using Logon Tickets with AS Java | Configuring the AS Java to Issue Logon Tickets |

- SAP NetWeaver 7.3 and higher:

  | Single Sign-On for Web-Based Access | Using Logon Tickets | Using Logon Tickets with AS ABAP | Configuring the AS ABAP to Accept Logon Tickets | Accepting Logon Tickets Issued by the AS Java |

6.1.3 Maintaining the Connection to the System Landscape Directory

After installing the Java system, you need to reconfigure the connection between the System Landscape Directory (SLD), the source system, and the target system.

The steps required differ depending on whether you use a local or a central SLD.

i Note

These steps are only required if the connection to the SLD was established on the source system before the split.

Prerequisites

SLDAPUSER credentials are available in the ABAP system.
Local SLD

1. Create users, groups, and roles as described in the SAP Library [page 12] for your release at:
   - Solution Life Cycle Management > Configuring, Working with and Administering System Landscape Directory > Administrating the SLD > Changing the SLD Configuration > Configuring SLD User Authorizations

2. Configure the SLD Server as described in the SAP Library [page 12] for your release at:
   - Solution Life Cycle Management > Configuring, Working with and Administering System Landscape Directory > Administrating the SLD > Changing the SLD Configuration > Configuring Server Parameters

3. Configure the ABAP Gateway in the SLD as described in the SAP Library [page 12] for your release at:
   - Solution Life Cycle Management > Configuring, Working with and Administering System Landscape Directory > Administrating the SLD > Changing the SLD Configuration > Configuring the SLD Bridge

4. Maintain the connection between the ABAP system and the SLD.
   1. Configure the SLD Data Supplier Service as described in the SAP Library [page 12] for your release at:
      - Solution Life Cycle Management > Configuring, Working with and Administering System Landscape Directory > Connecting Systems to the SLD > Connecting AS ABAP Systems to the SLD > Setting Up the SLD Data Supplier for AS ABAP-Based Systems

   2. Maintain the RFC destination as described in the SAP Library [page 12] for your release at:

   3. Maintain the HTTP connection parameters on the ABAP system as described in the SAP Library [page 12] for your release at:
      - Solution Life Cycle Management > Configuring, Working with and Administering System Landscape Directory > Connecting Systems to the SLD > Connecting AS ABAP Systems to the SLD > Using SLD API for AS ABAP-Based Systems > Creating an HTTP Destination for the SLD ABAP API on the AS ABAP Side

5. Maintain the connection between the Java system and the SLD.
   Configure the SLD Data Supplier Service as described in the SAP Library [page 12] for your release at:
   - Solution Life Cycle Management > Configuring, Working with and Administering System Landscape Directory > Connecting Systems to the SLD > Connecting AS Java Systems to the SLD > Setting Up the SLD Data Supplier for AS Java-Based Systems

6. If the former dual-stack system was registered to SLD, the system data of the dual-stack system were not deleted by running the configuration wizard. So you have to manually delete these system data from the SLD.
Central SLD

1. Create users, groups, and roles as described in the SAP Library [page 12] for your release at:
   - Solution Life Cycle Management ➤ Configuring, Working with and Administering System Landscape Directory ➤ Administering the SLD ➤ Changing the SLD Configuration ➤ Configuring SLD User Authorizations

2. Maintain the connection between the Java system and the SLD.
   Configure the SLD Data Supplier Service as described in the SAP Library [page 12] for your release at:
   - Solution Life Cycle Management ➤ Configuring, Working with and Administering System Landscape Directory ➤ Connecting Systems to the SLD ➤ Connecting AS Java Systems to the SLD ➤ Setting Up the SLD Data Supplier for AS Java-Based Systems

6.1.4 Enabling Recoverability of the IBM DB2 for Linux, UNIX, and Windows Database

Use

⚠️ Caution

This section only applies to your database. You only have to perform the steps outlined in this section once — even if you install multiple SAP systems into one database.

Roll forward recovery provides the ability to recover lost data due to media failure, such as hard disk failure, and applies log file information (log journal) against the restored database. These log files contain the changes made to the database since the last backup.

⚠️ Caution

A production system must run in log retention mode.

If a system is not running in log retention mode, all changes applied to the database since the last complete backup are lost in the event of a disk failure.

In log retention mode, the log files remain in the log directory (log_dir). To archive the log files, you can use DB2’s own log file management solution. For more information, see the Database Administration Guide — SAP on IBM DB2 for Linux, UNIX, and Windows.

Procedure

1. Log on to the database server as user `db2<dbsid>`.
2. To activate log retention mode and to specify the log archiving method, you must set configuration
parameter LOGARCHMETH1 to one of the following options:

○ LOGRETAIN
  No log archiving takes place. Log files remain in the log directory.

○ DISK:<log_archive_path>
  Log files are archived to a disk location. You can archive them to tape using the DB2 tape manager
  (db2tapiemgr) at a later point in time.

○ TSM:<TSM_management_class>
  Log files are archived to Tivoli Storage Management (TSM)

○ VENDOR:<path_to_vendor_lib>
  Log files are archived to a library that is provided by your vendor storage management

○ USEREXIT
  For downward compatibility with the former user exit concept, you can specify value USEREXIT for
  parameter LOGARCHMETH1.

To set configuration parameter LOGARCHMETH1 for your preferred archiving method, enter the following
command:

```
$ db2 update db cfg for <dbsid> using LOGARCHMETH1 <log.archiving.method>
```

For more information, see the Database Administration Guide — SAP on IBM DB2 for Linux, UNIX, and
Windows.

3. To activate the settings, you must restart the database. The database is now in backup pending mode. You
need to take an offline backup before you can continue.

4. If you plan to make a backup to tape on Windows, you have to initialize the tape drive by entering the
following command:

```
$ db2 initialize tape on \\.\<tape_device>
```

5. To start the offline backup for a single-partitioned database, enter the following command:

```
$ db2 backup db <dbsid> to <device>
```

**Example**

For example, to perform an offline backup of database **C11** to tapes in devices **TAPE0** and **TAPE1**, enter
the following command:

```
$ db2 backup database C11 to \\.\TAPE0, \\.\TAPE1
```

**Note**

On a multi partition database, you must activate log retention mode on all database partitions. In addition,
you also have to perform an offline backup for all database partitions.

For more information about how to start a DB2 backup, see the DB2 online documentation.

**More Information**

- For access to the Database Administration Guide — SAP on IBM DB2 for Linux, UNIX, and Windows and
  more documentation about SAP systems on IBM DB2 for Linux, UNIX, and Windows, see Online
  Information from SAP [page 85].
6.1.5 Follow-Up Activities for the Enhanced Change and Transport System

If you used the enhanced Change and Transport System as transport tool in your dual-stack system before the split, you need to reconfigure the transport routes within the landscape after installing the Java system.

The steps that you have to perform differ depending on the role of the split system within the transport landscape.

Also check the application-specific documentation for configuration details for CTS+ configuration. For SAP applications you can usually find this documentation at [http://scn.sap.com/docs/DOC-8576](http://scn.sap.com/docs/DOC-8576).

6.1.5.1 Configuring Source Systems for Non-ABAP Transports

In the source system, you have to perform the following configuration steps for non-ABAP transports.

**Procedure**

1. On the domain controller, use transaction STMS to create a non-ABAP system with the `<SAPSID>` of the new Java system. We recommend that you continue using the ABAP system of the former dual stack as communication system. To classify it as a source system, select the **Activate Organizer** flag.

   For more information, see the SAP Library [page 12] of your release at:

   ![Application Help](http://scn.sap.com/docs/DOC-8576)

   ![Function-Oriented View](http://scn.sap.com/docs/DOC-8576)

   ![Solution Life Cycle Management by Key Capability](http://scn.sap.com/docs/DOC-8576)

   ![Software Life Cycle Management](http://scn.sap.com/docs/DOC-8576)

   ![Software Logistics](http://scn.sap.com/docs/DOC-8576)

   ![Change and Transport System](http://scn.sap.com/docs/DOC-8576)

   ![Change and Transport System - Overview (BC-CTS)](http://scn.sap.com/docs/DOC-8576)

   ![Transporting Non-ABAP Objects in Change and Transport System](http://scn.sap.com/docs/DOC-8576)

   ![Performing Configuration Steps for Non-ABAP Transports](http://scn.sap.com/docs/DOC-8576)

   ![Defining and Configuring Non-ABAP Systems](http://scn.sap.com/docs/DOC-8576)

   **Note**

   Keep in mind that ABAP and non-ABAP objects can no longer be part of the same transport request. There will be different transport requests for ABAP objects and for non-ABAP objects.

2. In the domain controller, delete the parameters for non-ABAP transports from the configuration of the ABAP stack of the original dual-stack system.
6.1.5.2 Configuring Target Systems for Non-ABAP Transports

In the target system, you have to perform the following configuration steps for non-ABAP transports.

Procedure

1. Use transaction STMS to create a non-ABAP system with the <SAPSID> of the new Java system. We recommend that you continue to use the ABAP system of the former dual-stack as communication system. To classify it as a target system, select the Activate Deployment Service flag and make the appropriate settings for the deployment method.

   For information about individual applications, see the application-specific documentation for CTS+ configuration. For SAP applications which you can usually find at https://scn.sap.com/docs/DOC-8576.

   For general information about how to create a non-ABAP target system, see the SAP Library [page 12] of your release at:

   [Application Help] [Function-Oriented View] [Solution Life Cycle Management by Key Capability] [Software Life Cycle Management] [Software Logistics] [Change and Transport System] [Transport Management System (BC-CTS-TMS)] [Performing Configuration Steps for Non-ABAP Transports] [Defining and Configuring Non-ABAP Systems]

2. In the ABAP communication system, configure the CTS Deploy Web Service [page 71].

3. In the domain controller, delete the parameters for non-ABAP transports from the configuration of the ABAP stack of the original dual-stack system.

   For more information on the parameters, see Parameters for non-ABAP transports in the SAP Library [page 12] of your release at:

   [Application Help] [Function-Oriented View] [Solution Life Cycle Management by Key Capability] [Software Life Cycle Management] [Software Logistics] [Change and Transport System] [Transport Management System (BC-CTS-TMS)] [Performing Configuration Steps for Non-ABAP Transports] [Defining and Configuring Non-ABAP Systems]

4. If you have not cleaned up the import queue as described in the Preparation Checklist [page 29], you must copy the import buffer of the ABAP system to the Java system. This ensures the processing of pending transport queues.
Proceed as follows:

Copy the buffer file to a file named `<SAPSID of new Java system>` and move it to the following directory: `<Drive>:\usr\sap\trans\buffer`

### 6.1.5.3 Configuring the CTS Deploy Web Service

#### Context

After installing the Java system, you need to reconfigure the CTS Deploy Web Service.

This step is only required if you used the enhanced Change and Transport System as transport tool in your dual-stack system before the split and if the split system is used as a target system for "non-ABAP" transports.

For information about how to move the CTS Deploy Web Service host, see SAP Note [1823824](https://support.sap.com/).

#### Procedure

1. In your ABAP system in the client that you use for transports, call transaction SM59.
2. Check the CTS Deploy Web Service and adjust the host, port, and authentication details if required.

   For more information, see the Configuring the HTTP Connection section in Configuring the CTS Deploy Web Service in the SAP Library [page 12] of your release at:


   Use the new Java system as host of the system where the CTS Deploy Web Service runs.
3. We recommend that you use the new Connection Test to make sure that the connection works properly.

### 6.1.5.4 Configuring Transport Routes

#### Context

In the TMS of the domain controller, create the transport routes.
Procedure

- For the source system, create the transport routes between the new Java source system and the next system in the transport track.
- For the target system, create the transport routes between the previous Java system in the transport track and the new Java system, and between the new Java system and the next system in the transport track.

Next Steps

For more information, see the SAP Library [page 12] of your release at:

- Application Help
- Function-Oriented View <Language>
- Solution Life Cycle Management by Key Capability
- Software Life Cycle Management
- Software Logistics
- Change and Transport System
- Transport Management System (BC-CTS-TMS)
- Configuring TMS
- Configuring the Transport Routes

6.1.5.5 Splitting Within a System Landscape

Since an SAP system is usually part of a system landscape, dependencies between systems and adapting transport routes within the system landscape are topics to consider when planning a dual-stack split.

This section provides information for planning the dual-stack split within an exemplary system landscape composed of a development system (DEV), a test system (QAS), and a productive system (PRD), and it lists the required steps for adapting the transport routes.

![Figure 8: System Landscape Before Split](image)
Process Flow

1. You split the first system in the transport track. In this example this means that you split the dual-stack system DEV into an ABAP system DEV and a Java system JDS.
2. In the Transport Management System (TMS), you create a Java system (JDS) with the ABAP system (DEV) as communication system, and select the Activate Transport Organizer flag.
3. In the TMS, you delete the configuration settings of the Java system in the ABAP system (DEV).
4. In the TMS, you create the transport route between the new Java system (JDS) and the next system in the transport track (QAS).

![Figure 9: System Landscape After the First Split with Adapted Transport Routes](image)

5. You split the next system in the transport track. In this example this means that you split the dual-stack system QAS into an ABAP system QAS and a Java system JQS.
6. In the TMS, you create a Java system (JQS) with the ABAP system (QAS) as communication system, and select the Activate Deployment Service flag.
7. In the ABAP system (QAS), you adjust the CTS Deploy Web Service.
8. In the TMS, you delete the configuration settings of the Java system in the ABAP system (QAS).
9. If required, you copy the import buffer of the ABAP system (QAS) to the Java system (JQS). This ensures the processing of pending transport tracks.
10. In the TMS, you create the transport routes between the previous Java system in the transport track (JDS) and the new Java system (JQS) and between JQS and the next system in the transport track (PRD).
11. You split the next system in the transport track. In this example this means that you split the last dual-stack system in the transport track PRD into an ABAP system PRD and a Java system JPS.

12. In the TMS, you create a Java system (JPS) with the ABAP system (PRD) as communication system, and select the Activate Deployment Service flag.

13. In the ABAP system (PRD), you configure the CTS Deploy Web Service.

14. In the TMS, you delete the configuration settings of the Java system in the ABAP system (PRD).

15. You copy the import buffer of the ABAP system (PRD) to the Java system (JPS). This ensures the processing of pending transport tracks.

16. In the TMS, you create the transport route between the new Java system (JPS) and the Java system preceding in the transport track (JQS).
Related Information

Configuring Source Systems for Non-ABAP Transports [page 69]
Configuring Target Systems for Non-ABAP Transports [page 70]
Configuring the CTS Deploy Web Service [page 71]
Configuring Transport Routes [page 71]

6.1.6 Cleaning Up the System Landscape

To ensure data consistency for future maintenance, you have to clean up the system landscape data first in the SLD, and then in transaction SMSY, respectively the Landscape Management Database (LMDB) in the SAP Solution Manager.

Make sure that the entries for the removed Java stack are no longer part of the former dual-stack system in SLD and transaction SMSY, respectively LMDB.

1. Log on to the SLD User Interface (http://<Host_Name>:port/sld).
2. In the Technical Systems view, locate the Java System that you previously have split from the dual stack and remove it.
3. Remove the obsolete Java System from the SAP Solution Manager:
   ○ In SAP Solution Manager 7.1, the deletion of the Java system in the SLD is propagated automatically to LMDB and SMSY.
   ○ If you still operate a SAP Solution Manager 7.01 system, call transaction SMSY and delete the technical system of type “Java”.
   ○ If the Java system is still in use – for example, in a Product System or Logical Component – you must first remove it from all uses.

More Information

For more information about how to proceed, see the following:

- SAP Note 1873543 and http://support.sap.com/solutionmanager.
7 Additional Information

7.1 Move Java Database: Restoring Instances

Use

If you encounter severe problems during the split and decide to stop it, you can use the source system as a dual-stack system again. You then have to restart all instances of the source system.

Note

This is only possible if you have not yet removed the Java stack of the dual-stack source system.

Procedure

1. Edit the primary application server instance profile
   `<SAPSID>_DVEBMGS<Instance_Number>_<Host_Name>`: Replace the line `rdisp/j2ee_start=0` with `rdisp/j2ee_start=1`.
2. Restart the primary application server instance service.
   In SAP MMC, choose All tasks Restart service.
3. Restart the instance by calling transaction SMICM.
4. Open the default profile and add the profile parameter:
   `icm/HTTP/ASJava/disable_url_session_tracking = TRUE`

7.2 Keep Database: Restoring Instances

Use

If you encounter severe problems during the split and decide to stop, you can use the source system as a dual-stack system again. You then have to restart all instances of the source system.

Note

This is possible only if you have not yet removed the Java stack of the dual-stack source system.
Procedure

1. If you have already executed the option *Install Java Primary Application Server* to install the AS Java target system, proceed as follows:
   1. **MS SQL Server, SAP MaxDB**: Rename the Java database schema to its original value (for example, `SAP<SAPSID>_Dual-Stack_System_DB`), depending on your database vendor.
   2. Start the GUI ConfigTool and choose Tools ➤ Configuration Editor ➤ Open ➤ Configurations ➤ destinations ➤ RFC ➤ Propertiesheet UMEBackendConnection and restore the default values of the properties `jco.client.ashost` and `jco.client.sysnr`.
   2. Edit the primary application server instance profile
      `<SAPSID>_DVEBMGS<Instance_Number>_<Host_Name>`: Replace the line `rdisp/j2ee_start=0` with `rdisp/j2ee_start=1`.
   3. Restart the primary application server instance service.
   4. Restart the instance by calling transaction `SMICM`.
   5. Open the default profile and add the profile parameter:
      `icm/HTTP/ASJava/disable_url_session_tracking = TRUE`

7.3 Removing the Java Stack

Use

Using this procedure, you will permanently delete the Java stack from the system without the need to start the dual stack split procedure.

**Note**

During the removal process, all Java database content, all Java file systems and subdirectories of the Java stack are deleted. Before you start, make sure that you have saved a copy of all files and directories that you want to keep to a secure location.

Prerequisites

Before you start the removal procedure, perform the following:

- Shut down the J2EE cluster using transaction `SMICM`
- Set `rdisp/j2ee_start = 0` in the primary and all additional application server instance profiles
- Restart the instance services as follows:
  - **Windows**:
    - In SAP MMC on the relevant instances, choose All tasks ➤ Restart service
UNIX/IBM i:
Log on as <sapsid>adm and execute the following for the relevant instances:

```
sapcontrol -nr <Instance_Number> -function RestartService
```

### Procedure

1. Start the tool and choose split option Move Database as described in Running the Installer [page 47].
2. Depending on your system variant, perform the steps listed below:
   - **Standard System**
     - Remove Java Stack from Dual-Stack System
   - **Distributed System**
     - Remove Java Stack from Dual-Stack Additional Application Server Instance
     - Remove Java Stack from Dual-Stack Primary Application Server Instance
     - Remove SCS Instance from Dual-Stack System
     - Remove Java Schema of Dual-Stack Database Instance
   - **High-Availability System**
     - Remove Java Stack from Dual-Stack Additional Application Server Instance
     - Remove Java Stack from Dual-Stack Primary Application Server Instance
     - Remove SCS Instance from Dual-Stack System
     - Remove ERS Instance from Dual-Stack System
     - Remove Java Schema of Dual-Stack Database Instance

   **Caution**
   You must skip the export and installation steps.

3. After you remove the Java stack, you have to remove the Java stack data from the SLD, transaction SMSY and LMDB in the SAP Solution Manager.
   For more information, see Cleaning Up the System Landscape [page 75].
   The removal of the technical Java system from the SLD is important for the system landscape data consistency.

### 7.4 Performing a Domain Installation Without Being a Domain Administrator

You normally perform a domain installation of the SAP system with a user who is a member of the domain Admins group, as described in Required User Authorization for Running the Installer [page 32]. If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the domain administrator has to prepare the system appropriately for you. The domain administrator can perform the following steps either using the installer or manually:

1. Create the new global group `SAP_<SAPSID>_GlobalAdmin`. 
2. Create the two new SAP system users <sapsid>adm and SAPService<SAPSID>.
3. Add the users <sapsid>adm and SAPService<SAPSID> to the newly created group SAP_<SAPSID>_GlobalAdmin.
4. The following steps are only required for IBM DB2 for Linux, UNIX and Windows:
   1. Create the database administration group db<dbsid>adm, the database control group db<dbsid>ctl, the database maintenance group db<dbsid>mnt, and the database monitoring group db<dbsid>mon.
   2. Create the new DB2 database administrator db2<dbsid>.
   3. Add users <sapsid>adm and SAPService<SAPSID> to the group db<dbsid>ctl. Add the user db2<dbsid> to the group db<dbsid>adm.
   4. If you want the database connect user (sap<sapsid>db) to be part of the <sapsid>adm domain, you have to add it to the group db<dbsid>mon manually.

⚠️ Caution

You can specify the name of the Java connect user (sap<sapsid>db) independently from the SAP schema name during the dialog phase of the installer.

We recommend, however, that you keep the names of the connect user and the database schema identical in standard use cases. If you are performing a system copy using database means, DB2 is not able to change the schema name and you can then choose a connect user name that is different from the schema name.

Make sure that you choose the correct value during the dialog phase of the installer.

5. Create the database extended security groups DB2ADMNS_<DBSID> and DB2USERS_<DBSID>.
6. Add users db2<dbsid> and SAPService<SAPSID> to the database extended security group DB2ADMNS_<DBSID>.

ℹ️ Note

The installer creates the operating system user for the SAP Host Agent by default as a local user that is not a member of the local Administrators group. If you want to create this user manually as a domain user, you must perform the following steps:

Creating the SAP Host Agent User and Group Manually

1. Create the new global group SAP_SAP_GlobalAdmin.
2. Create the SAP system user sapadm.
3. Add the user sapadm to the newly created group SAP_SAP_GlobalAdmin.

However, for security reasons we strongly recommend you to create this user as a local user.

Prerequisites

- You must be domain administrator to perform the required steps.
You must have installed the feature Remote Server Administration Tools as follows:

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  ```cmd
  add-windowsfeature RSAT-ADDS
  ```

- Windows Server 2008 (R2):
  1. Choose Start ➤ Administrative Tools ➤ Server Manager ➤ Server Manager window, select Features.

### Procedure

**Creating the Required Users and Groups Using the Installer**

On the host where the SAP system is to be installed, the domain administrator starts the installer as described in Running the Installer [page 47] and chooses Generic Installation Options ➤ Preparations ➤ Operating System Users and Groups to have the group and users created automatically.

**Creating the Required Users and Groups Manually**

**Note**

To create the users and groups specific to the SAP Host Agent, you must follow the procedure below, and replace the users and groups with those for the SAP Host Agent.

**Creating the New Global Group SAP_<SAPSID>_GlobalAdmin**

Perform the following steps:

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  ```cmd
  net group SAP_<SAPSID>_GlobalAdmin /add /domain
  ```

- Windows Server 2008 (R2):
  1. Log on as domain administrator.
  2. Start the Active Directory Users and Computers Console by choosing:
     Start ➤ Control Panel ➤ Administrative Tools ➤ Active Directory Users and Computers
  4. Enter the following:
     Group name: SAP_<SAPSID>_GlobalAdmin
     Group scope: Global
     Group type: Security
  5. Choose OK.

**Creating the New SAP System Users <sapid>adm and SAPService<SAPSID>**
Perform the following steps:

- **Windows Server 2012 (R2) and higher:**
  1. Open PowerShell in elevated mode.
  2. Create the `<sapsid>adm` user with the following command:
     ```
     net user <sapsid>adm <Password> /add /domain
     ```
  3. Create the `SAPService<SID>` user with the following command:
     ```
     net user SAPService<SID> <Password> /add /domain
     ```

- **Windows Server 2008 (R2):**
  1. In *Active Directory Users and Computers Console*, right-click *Users* in *Tree* and choose:
     - *New* > *User*
  2. Enter the following:

     Table 8:

     | Field      | Input for `<sapsid>adm` | Input for `SAPService<SID>` |
     |------------|-------------------------|----------------------------|
     | First name | None                    | None                       |
     | Initials   | None                    | None                       |
     | Last name  | None                    | None                       |

  3. Choose *Next* and enter the following:
     - *Password*: `<Password>`
     - *Confirm password*: `<Password>`
  4. Select *Password never expires*.

     - **Note**
     Make sure that no other options are selected.
  5. Choose *Next* > *Finish*.

**Adding the Manually Created Users to Groups**

- **Windows Server 2012 (R2) and higher:**
  Open PowerShell in elevated mode, and enter the following command:
  ```
  net group SAP_<SID>_GlobalAdmin <sapsid>adm /add /domain
  ```
- **Windows Server 2008 (R2):**
  1. In the *Users* folder, double-click the newly created user account `<sapsid>adm` in the list on the right.
  2. Choose *Member* > *Add*.
  3. Select the new `SAP_<SID>_GlobalAdmin` group and choose *Add* to add it to the list.

**Dual-Stack Split for SAP Systems Based on SAP NetWeaver 7.1 to 7.5 on Windows**

**Additional Information**

- **CUSTOMER**
  81
By default, the user is also a member of the Domain Users group.

4. Choose OK twice.

Adding the SAPService<SAPSID> User to the SAP_<SAPSID>_GlobalAdmin Group

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  \texttt{net group SAP_<SAPSID>_GlobalAdmin SAPService<SAPSID> /add /domain}
- Windows Server 2008 (R2):
  1. In the Users folder, double-click the newly created user account \texttt{SAPService<SAPSID>}
     in the list on the right.
  2. Choose \texttt{Member Add}
  3. Select the new \texttt{SAP_<SAPSID>_GlobalAdmin} group.
  4. Choose \texttt{Add} to add it to the list, and then \texttt{OK}.
  5. Choose \texttt{OK} to close \texttt{SAPService<SAPSID>Properties}.

7.5 Using PowerShell

SAP uses Windows PowerShell to run and describe Windows commands.

For Windows Server 2012 (R2) and higher, SAP only uses Windows PowerShell to run and describe Windows commands.

Windows PowerShell is a powerful tool integrated in the Windows operating system. It uses object-oriented methodology, which allows fast and stable script development.

For more information about the Windows PowerShell, see:

\texttt{http://technet.microsoft.com/en-us/scriptcenter/dd742419.aspx}

There you can find links to the online help, online documentation, scripting repository, downloads, and blogs.

If you want to use the PowerShell feature, note the following:

- Windows Server 2016
  Windows Server 2016 contains PowerShell 5.0
  You can update to PowerShell 5.0 (search the internet for Windows Management Framework 5.0).
- Windows Server 2012 R2
  Windows Server 2012 R2 contains PowerShell 4.0.
- Windows Server 2012
  You can update to PowerShell 4.0 (search the internet for Windows Management Framework 4.0).
- Windows Server 2008 R2
  Windows Server 2008 R2 contains PowerShell 2.0.
  For more information about PowerShell 2.0, see \texttt{http://support.microsoft.com/kb/968929}.
  You can update to PowerShell 3.0 or 4.0 (search the internet for Windows Management Framework 3.0 or Windows Management Framework 4.0).
Windows Server 2008

You have to activate the PowerShell feature with Start > Administrative Tools > Server Manager > Features.


How to Start PowerShell

⚠️ Caution

Make sure that you start the PowerShell in administrator mode.

- Windows Server 2012 (R2) and higher
  Open the command prompt and enter the command:
  `powershell.exe`

To start PowerShell on Windows Server 2008 (R2), you have the following options:

- From the command prompt, by entering the command:
  `powershell.exe`
- From the Start Menu:
  - PowerShell 1.0:
    Choose Start > All Programs > Windows PowerShell 1.0 > Windows PowerShell.
  - PowerShell 2.0:
    Choose Start > All Programs > Windows PowerShell > Windows PowerShell.

How to Work with PowerShell

Most commands that are used in `cmd.exe` are also available in the PowerShell (defined as aliases).

You can use well-known commands, such as `cd`, `type`, `copy`, `move`, `mkdir`, `delete`, `rmdir`. There is also online help available, which you can access by typing the command: `help` (or `help <command>`).

This is a list of differences between PowerShell and `cmd.exe`:

- Before you can run PowerShell scripts (text files with the file extension `.ps1` that contain PowerShell statements), you might have to change the default security setting to allow the execution of non-signed scripts as follows:
  `set-executionpolicy "unrestricted"`
- By default, when double-clicking PowerShell scripts (.ps1 files) in the Windows explorer, this does not execute the script as is the default for `.cmd` files, but opens the script in an editor. If you want to activate automatic script execution after a double-click, you have to change the value `HKEY_CLASSES_ROOT \Microsoft.Powershellscript.1\Shell\Open\Command from notepad.exe to the full path of the PowerShell executable.
- The output of PIPE commands is not just a stream of characters (strings) but a stream of objects. You can easily access the properties and methods for these objects (see the process list DLL example below).
The current working directory is not part of the directory search path that the PowerShell looks at for scripts and programs. The PowerShell only searches directories listed in the environment variable path. Therefore, you might have to run a local program with `./sapcontrol.exe` or specify its full path.

You can use the UNIX-like directory delimiters, such as `cd /usr/sap/C11`.

You can have your current working directory in a UNC path (`cd \sapglobalhost\sapmnt`).

The shell distinguishes between environment variables and shell variables:

- Use of shell variables:
  
  Definition: `$x="hello"`
  
  Reference: `write-host $x`

- Use of an environment variable:
  
  Definition: `$env:x="hello"`
  
  Reference: `write-host $env:x`

The PowerShell has an interesting container concept called ps-drives. Within ps-drives you can navigate in other objects, such as the registry or shell internal lists in the same way as you typically navigate in a file system (`cd`, `dir`, `del`, and so on).

- `dir env:` to get a list of environment variables
- `dir variable:` to get the list of shell variables
- `dir HKLM:` to get a list of registry keys in HKEY_LOCAL_MACHINE
- `get-psdrive` to get a list of available ps-drives

Windows PowerShell has full access to the .NET runtime. You can directly access missing functions in the PowerShell via .NET.

With Windows PowerShell, you can create GUI-class user interfaces using Windows forms.

### PowerShell Commands

The following table lists some PowerShell commands that are available on Windows Server 2012 (R2) and higher:

Table 9:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>stop-service sap*</code></td>
<td>Stops all Windows services with service name starting with “SAP”</td>
</tr>
<tr>
<td><code>get-process</code></td>
<td>Lists currently started processes on your system</td>
</tr>
<tr>
<td>`get-process</td>
<td>sort starttime</td>
</tr>
<tr>
<td>`get-process</td>
<td>sort starttime</td>
</tr>
<tr>
<td>`get-process</td>
<td>sort starttime</td>
</tr>
</tbody>
</table>
### Command Explanation

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>`get-process</td>
<td>%($<em>.name;&quot;-----------&quot;;$</em>.modules)`</td>
</tr>
<tr>
<td>`$processes = (get-process</td>
<td>sort starttime)`</td>
</tr>
<tr>
<td><code>$processes.length</code></td>
<td>The number of processes in the array (is equivalent to the number of processes on your computer)</td>
</tr>
<tr>
<td><code>$processes[$processes.length-1].kill()</code></td>
<td>Invokes the kill method (terminate process) of the last started process</td>
</tr>
<tr>
<td><code>(dir a.txt).set_attributes(&quot;readonly&quot;)</code></td>
<td>Sets the file <code>a.txt</code> to “read-only”</td>
</tr>
</tbody>
</table>

### 7.6 Online Information from SAP

More information is available online as follows:

Table 10: Documentation

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation guide for SAP systems running on IBM DB2 10.1 or higher with the pureScale Feature</td>
<td><a href="http://service.sap.com/instguidesnw">http://service.sap.com/instguidesnw</a></td>
<td>Database Installation Guide: Running an SAP System on IBM DB2 &lt;Version&gt; with the pureScale Feature</td>
</tr>
<tr>
<td>Description</td>
<td>Internet Address</td>
<td>Title</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Database administration using the DBA Cockpit</td>
<td><a href="http://service.sap.com/instguidesnw">http://service.sap.com/instguidesnw</a></td>
<td>Database Administration Using the DBA Cockpit: IBM DB2 for Linux, UNIX, and Windows</td>
</tr>
<tr>
<td>Administration tasks for SAP BW systems on IBM DB2 for Linux, UNIX, and Windows</td>
<td><a href="http://service.sap.com/instguidesnw">http://service.sap.com/instguidesnw</a></td>
<td>SAP Business Warehouse on IBM DB2 for Linux, UNIX, and Windows: Administration Tasks</td>
</tr>
<tr>
<td>Database Administration Guide for SAP systems running with IBM DB2 for z/OS</td>
<td><a href="http://service.sap.com/instguidesnw">http://service.sap.com/instguidesnw</a></td>
<td>Database Administration Guide: SAP on IBM DB2 for z/OS</td>
</tr>
<tr>
<td>SAP Security Guide for SAP systems running with IBM DB2 for z/OS (was formerly part of the Planning Guide SAP on IBM DB2 for z/OS)</td>
<td><a href="http://service.sap.com/instguidesnw">http://service.sap.com/instguidesnw</a></td>
<td>Security Guide for SAP on IBM DB2 for z/OS</td>
</tr>
<tr>
<td>SAP on DB2 for z/OS</td>
<td><a href="http://scn.sap.com/community/db2-for-z-os">http://scn.sap.com/community/db2-for-z-os</a></td>
<td>SAP on DB2 for z/OS Community</td>
</tr>
</tbody>
</table>
7.7 Online Information from IBM

You can use the following IBM DB2 for Linux, UNIX, and Windows welcome page as a starting point to all kinds of documentation for your relevant database version: http://www.ibm.com/support/knowledgecenter/en/SSEPGG

The following tables provide direct links to IBM DB2 online documentation and manuals, listed by database version:

Table 11: IBM DB2 Knowledge Center

<table>
<thead>
<tr>
<th>Database Version</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 V9.5</td>
<td><a href="http://publib.boulder.ibm.com/infocenter/db2luw/v9r5/index.jsp">http://publib.boulder.ibm.com/infocenter/db2luw/v9r5/index.jsp</a></td>
</tr>
<tr>
<td>DB2 V9.7</td>
<td><a href="http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/index.jsp">http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/index.jsp</a></td>
</tr>
<tr>
<td>DB2 10.1</td>
<td><a href="http://publib.boulder.ibm.com/infocenter/db2luw/v10r1">http://publib.boulder.ibm.com/infocenter/db2luw/v10r1</a></td>
</tr>
<tr>
<td>DB2 10.5</td>
<td><a href="http://publib.boulder.ibm.com/infocenter/db2luw/v10r5/index.jsp">http://publib.boulder.ibm.com/infocenter/db2luw/v10r5/index.jsp</a></td>
</tr>
</tbody>
</table>

Table 12: IBM Manuals

<table>
<thead>
<tr>
<th>Database Version</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 V9.5</td>
<td><a href="http://www.ibm.com/support/docview.wss?rs=71&amp;uid=swg27009727">http://www.ibm.com/support/docview.wss?rs=71&amp;uid=swg27009727</a></td>
</tr>
<tr>
<td>DB2 10.5</td>
<td><a href="http://www.ibm.com/support/docview.wss?uid=swg27038855">http://www.ibm.com/support/docview.wss?uid=swg27038855</a></td>
</tr>
</tbody>
</table>
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings (“Code”) included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with “you”, or a gender-neutral noun (such as “sales person” or “working days”) is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).

Open Source Software and Third Party Components

Please refer to https://scn.sap.com/docs/DOC-42044 for information respecting open source software components made available by SAP as part of SAP NetWeaver and any specific conditions that apply to your use of such open source software components. Please refer to https://scn.sap.com/docs/DOC-42045 for information relating to SAP’s use of third party software with or within SAP NetWeaver.